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About this Manual

Welcome to the User’s Guide for the Agilent 2100 expert software. This manual provides 
beginners and advanced users with information needed to successfully run 
electrophoretic and flow cytometric assays with the bioanalyzer.

The 2100 expert software allows the control of the bioanalyzer (including diagnostic 
functions) and, in combination with a LabChip kit, the acquisition, interpretation and 
result presentation of data generated during the analysis of DNA, RNA, proteins, and 
cells.
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In this Manual

This manual provides bioanalyzer users with the following information:

• “About this Manual” on page 5 gives an overview of the subjects in this manual, and 
lists major innovations and improvements of the 2100 expert software. It also lists 
supplemental literature and shows you how to make efficient use of this manual.

• “Quick Start” on page 15 is meant for experienced users. It briefly summarizes the 
necessary steps to prepare and run an assay. 

• “Looking at 2100 Expert” on page 29 shows how to get started with the 2100 expert 
software, and outlines its main operational possibilities.

• “Running and Evaluating Electrophoretic Assays” on page 46 explains how 
electrophoretic measurements are made using the bioanalyzer, gives detailed 
descriptions of all steps necessary to run electrophoretic assays, and shows how to 
analyze and evaluate results using electropherograms and gel-like images.

• “Running and Evaluating Flow Cytometric Assays” on page 171 explains how flow 
cytometric measurements are made using the bioanalyzer, gives detailed descriptions 
of all steps necessary to run flow cytometric assays, and shows how to analyze and 
evaluate results using histograms and dot plots.

• “Working with Chip Data and Assays” on page 264 shows you what to do to open, save, 
import and export files, and how to print the results.

• “Administering System Functions” on page 305 is your guideline for configuring the 
2100 expert software.

• “Running Instrument Diagnostics” on page 322 shows how to use the diagnostic tests 
to check the bioanalyzer hardware for proper functioning.
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• “Performing Verifications” on page 331 describes how you can validate your 
bioanalyzer system. 

• “Products, Spare Parts, and Accessories” on page 340 lists all parts and 
accessories—including reorder numbers—that are required for electrophoretic and 
flow cytometric measurements.

• “Glossary” on page 344 explains terms in context with flow cytometry, electrophoresis, 
and terms specific to the bioanalyzer software and hardware.

If you have any questions this manual cannot answer, please refer to the supplemental 
literature listed in “Related Documents” on page 8. If you still have questions, contact 
Agilent for additional support at:

http://www.agilent.com/chem/labonachip 

http://www.agilent.com/chem/labonachip
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Related Documents

A collection of supplemental literature is given in the following. 

Bioanalyzer Manuals

CD-ROM

Reagent Kit Guides

The Reagent Kit Guides give you information on how to perform specific assays, 
including sample and chip preparation.

Publication Number Title

G2938-90006 Agilent 2100 Bioanalyzer Installation and Safety Manual

G2946-90003 Agilent 2100 Bioanalyzer Maintenance and Troubleshooting 
Guide

Publication Number Title

G2946-60002 Agilent 2100 Bioanalyzer – How to Use Multimedia CD-ROM

P/N Title

G2938-90301 Kit Guide Binder english (including new Reagent Kit Guides)

G2938-90012 Reagent Kit Guide DNA 1000 Assay

G2938-90022 Reagent Kit Guide DNA 7500 and DNA 12000 Assay
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Quick Guides

The Quick Guides give you short information on how to prepare samples.

G2938-90032 Reagent Kit Guide RNA 6000 Nano Assay

G2938-90042 Reagent Kit Guide RNA 6000 Pico Assay

G2938-90052 Reagent Kit Guide Protein 230 Assay

G2938-90062 Reagent Kit Guide Protein 80 Assay

G2938-90072 Reagent Kit Guide Cell Assay

G2938-90082 Reagent Kit Guide Cell Checkout Kit

P/N Title

G2938-90011 Quick Guide 1000 Assay

G2938-90021 Quick Guide DNA 7500 and DNA 12000 Assay

G2938-90031 Quick Guide RNA 6000 Nano Assay 

G2938-90041 Quick Guide RNA 6000 Pico Assay 

G2938-90051 Quick Guide Protein 230 Plus Assay

G2938-90061 Quick Guide Protein 80 Assay 

G2938-90071 Quick Guide Cell Assay

G2938-90081 Quick Guide Cell Checkout Kit

P/N Title
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Application Notes and Technical Notes

Application Notes and Technical Notes are available from the Agilent 2100 Bioanalyzer 
Help Desk or from the lab-on-a-chip web pages:

http://www.agilent.com/chem/labonachip 

Newly Published Documentation

Follow this link to see if there is any new documentation:

http://www.chem.agilent.com/scripts/Library.asp 

http://www.agilent.com/chem/labonachip
http://www.chem.agilent.com/scripts/Library.asp
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How to Use this Manual

This manual uses convenient online navigation features and follows certain typographic 
conventions.

Online Navigation

Use the interactive bookmarks in this 
frame to move to your desired topic.

Use Acrobat Reader’s navigation bar 
to move around within a topic.

Here is the current page number.
▲ Displays the previous page.

▼ Displays the next page.

Click here to go to the index.Click here to go to the table of contents.



Contents ▲ 12 ▼ Index

After you have chosen a topic with the bookmarks, use the buttons in Acrobat Reader’s 
toolbar to move around within the topic.

Displays the first page.

Displays the last page.

Returns to the next view. 
Click several times to redo 
more view changes.

Returns to the previous view. 
Click several times to undo 
more view changes.

Displays the previous page.

Displays the next page.
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Layout Conventions

The following typographic conventions are used in this manual:

Highlight Meaning

Italic On-screen element
Example: ... the OK button.

Emphasis
Example: Right-click the ...

Term
Example: Dot plots show events as dots.

Reference to another document
Example: Refer to the Agilent 2100 Bioanalyzer Troubleshooting and 
Maintenance Guide.

Blue Cross-reference or hyperlink
Examples:
“Introduction to the Key Features of the 2100 expert” on page 30
http://www.agilent.com/chem/labonachip 

Courier Code
Example: .. the command line parameter -port 2 ...

Courier 
bold

User input
Example: Enter 50 MB.

http://www.agilent.com/chem/labonachip
http://www.agilent.com/chem/labonachip
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Safety Notices, Notes and Tips

Safety notices, notes and tips in this document have the following meaning:

WARNING
A warning notice denotes a hazard. It calls attention to an operating procedure, 
practice, or the like that, if not correctly performed or adhered to, could result in 
personal injury or death. Do not proceed beyond a warning notice until the indicated 
conditions are fully understood and met.

CAUTION
A caution notice denotes a hazard. It calls attention to an operating procedure, 
practice, or the like that, if not correctly performed or adhered to, could result in 
damage to the product or loss of important data. Do not proceed beyond a caution 
notice until the indicated conditions are fully understood and met. 

NOTE
A note contains important, helpful, or additional information.

T IP
A tip usually points out a timesaving feature.
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Quick Start

The following step-by-step instructions guide you through a measurement with the 
Agilent 2100 bioanalyzer.

Preparing the Agilent 2100 Bioanalyzer

1 Ensure that the proper cartridge is installed in the bioanalyzer. You can identify the 
installed cartridge by the number engraved at the front. 

! = Electrode Cartridge for electrophoretic assays
" = Pressure Cartridge for flow cytometric assays

Engraved number

Note that there are also electrode cartridges 
without an engraved number.
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2 If you have to change the cartridge, follow the instructions in “Loading the 
Electrophoresis Chip into the Bioanalyzer” on page 59 or “Loading the Cell Chip into the 
Bioanalyzer” on page 194, respectively.

Switching on the Agilent 2100 Bioanalyzer

1 Make sure the bioanalyzer is connected to line power and connected to the PC.

2 Turn on the line switch at the rear of the instrument.

The status LED at the front of the bioanalyzer should light up.

Lid

Status LED
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The status LED shows you the current status of the instrument.

Running a Measurement

1 To start the 2100 expert software on the connected PC, go to your desktop and 
double-click the following icon:

Signal Meaning

Green light Instrument is switched on and ready for measurement.

Green blinking Measurement is running.

Orange blinking Instrument is busy (running self diagnostic, for example).

Red light Instrument is not ready for measurement. Switch the instrument off 
and on again. If the problem persists, call Agilent service.
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After startup of the software, you enter the Instrument context:

NOTE
If you started 2100 expert for the first time after installation, you first need to activate 
the different software modules with your license keys. See Figure ,“How to Activate 
Software Licenses” for details.
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The Instrument tab shows you the status of the bioanalyzer:

2 Make sure that a bioanalyzer has been detected before continuing.

Icons Meaning

Bioanalyzer detected, lid is open.

Bioanalyzer detected. Lid is closed, but no chip is inserted.

No bioanalyzer has been detected. 

Check the COM Port setting (see figure under step 3), the RS 232 
connection cable, the power cable, and the power switch. For 
details on how to set up the bioanalyzer and connect it to a PC, see 
Agilent 2100 Bioanalyzer Installation and Safety Guide.
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3 Select an assay for the chip run.

On the Instrument tab, click the Assays button.

– OR – 

Click the Assays menu.

Both will open a menu, allowing you to select an assay for the measurement.

Note that you can also select File > Open File to Run. This opens a dialog box allowing 
you to load either an assay (.xsy) or a chip data file (.xad).

4 Prepare the samples and the chip.

For detailed information on sample and chip preparation refer to:

– Reagent Kit Guides that are available for each reagent kit

– Application Notes that are available for specific kits and applications

NOTE
When preparing chip and samples, pay attention to the essential measurement 
practices described in “Essential Measurement Practices (Electrophoretic Assays)” 
on page 56 and “Essential Measurement Practices (Flow Cytometric Assays)” on 
page 192 or as described in the respective Reagent Kit Guide.
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5 Insert the chip in the Agilent 2100 bioanalyzer:

a Open the lid.

The status of the bioanalyzer is updated on the Instrument tab.

b Check that the cartridge is inserted properly and the chip selector is in the correct 
position (“1” for electrophoretic assays, “2” for flow cytometric assays).

For details, please refer to “Loading the Electrophoresis Chip into the Bioanalyzer” 
on page 59 or “Loading the Cell Chip into the Bioanalyzer” on page 194, respectively.
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c Place the chip into the receptacle. The figure shows this for an electrophoresis chip.

The chip fits only one way. Do not force it into place.

CAUTION
Do not force the lid closed. This may damage the cartridge.

d Carefully close the lid.

Electrophoretic assays: the electrodes in the cartridge fit into the wells of the chip.

Flow cytometric assays: the adapter with the gasket in the cartridge fits onto the 
priming well of the chip. 

Chip
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When the chip is detected, the image on the Instrument tab changes to a chip.

If the chip is not detected, open and close the lid again.

NOTE
If the AutoRun option is active, the chip run starts automatically once a chip has been 
inserted and the lid has been closed.

6 On the Instrument tab, click the Start button.

The chip run starts. The Raw Signals sub-tab shows an electropherogram of the currently 
measured sample. The name of the sample is displayed above the graph. The graph is a 
“live” plot of the migration time against fluorescence units (raw data, including 
background fluorescence, for example).
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The number of the sample that is currently being measured is indicated on the 
information bar:

The status bar at the bottom of the window shows the measurement progress for the 
chip run and the COM port number used for data acquisition.
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During the chip run, you can do the following:

• View the chip data file in the Data context by clicking on the name of the Data File:

• Switch to any other context. For example, you can evaluate any chip data file in the Data 
context, or compare samples in the Comparison context.

• If necessary, abort the chip run by clicking on the Stop button. 

All data that was collected up to the stop point will be saved.
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Viewing the Measurement Results

To view the results, switch to the Data context. The data file that has just been 
generated by your chip run is displayed. The Chip Summary tab shows information on 
your chip data file, and lets you enter comments regarding chip, samples, and study.

In the tree view panel, click any sample name or the ladder.
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This selects the Electropherogram tab, which displays a data plot of size/migration 
time versus fluorescence intensity.

Peaks have automatically been detected, and their characteristics such as size, 
concentration, purity, or molarity have been calculated and are shown in the Peak Table 
at the bottom of the window.
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What You Can do When the Measurement is Finished

When the measurement is finished, you can:

• Document your chip run by entering sample names, chip comments, and study 
information, for example.

• Evaluate the measurement results by analyzing gel-like images and electropherograms 
(electrophoretic assays), or histograms and dot plots (flow cytometric assays):

– “Analyzing and Evaluating the Results of an Electrophoretic Assay” on page 82

– “Analyzing and Evaluating the Results of a Flow Cytometric Assay” on page 217

• Print the results to document them on paper or an electronic format, such as HTML or 
PDF.

See “Printing Reports” on page 292.

• Export the results or parts of them for further evaluation in other applications.

See “Exporting Data” on page 283.

• Compare the results with the results of other chip runs in the Comparison context. See 
“Comparing Samples from Different Electrophoretic Chip Runs” on page 148.

• Insert the next chip in the bioanalyzer and start a new chip run.
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Looking at 2100 Expert

Before you start running assays on the Agilent 2100 bioanalyzer, you should familiarize 
yourself with the 2100 expert software:

• “Introduction to the Key Features of the 2100 expert” on page 30

• “Starting 2100 Expert” on page 32

• “2100 Expert Work Area” on page 33

• “Closing 2100 Expert” on page 44
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Introduction to the Key Features of the 2100 expert

The Agilent 2100 expert is characterized by the following key features:

• 2100 expert provides a single software platform with a common user interface for 
running, analyzing, evaluating, presenting, and comparing DNA, RNA, protein and cell 
parameters.

• 2100 expert is installed in one go. After installation, the functionality for electrophoretic 
and flow cytometric assays can be activated separately with license keys.

• 2100 expert provides an optional security pack that needs to be ordered separately as 
G2949CA and is then activated with a license key. This security pack activates user 
management functions and electronic signature to meet the Food and Drug 
Administration (FDA) requirements (21 CFR Part 11).

• 2100 expert provides detailed installation verification and system verification tests on 
both the bioanalyzer hardware and software.

• 2100 expert allows having multiple chip data and/or assay files open at the same time.

• 2100 expert features a new integrated data evaluation tool (Comparison context) 
allowing comparison of measurement results (of same assay class) from different chips 
directly. A separate data evaluation tool is no longer necessary.

• 2100 expert features improved integration including manual integration (available for 
DNA and Protein assays only).

• 2100 expert allows color-coded result flagging with pre-defined or custom result 
flagging rules. Flagging rules can be applied to measurement results.

• 2100 expert now has customizable result tables and gel-like images.
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• 2100 expert has improved instrument control. Two bioanalyzers can be controlled at 
one time. It is possible to run measurements as well as diagnostics tests on two 
bioanalyzers at the same time.

• 2100 expert has improved printing and reporting functions.

• 2100 expert has extended instrument diagnostics functionality.
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Starting 2100 Expert

To start 2100 expert:

1 Go to your desktop and double-click the following icon:

– OR –

From the Windows Start menu, select Programs > Agilent 2100 Bioanalyzer > 2100 
expert.
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2100 Expert Work Area

The 2100 expert software has standard elements such as pull-down menus and toolbars, 
and the main working area, which contains several tabs, some of which have sub-tabs. 
The 2100 expert work area has the following regions (demonstrated at the Data context):

Menu Bar

Info Bar

Tree View

Tabs

Status Bar

Toolbar

Title Bar

Lower 
Panel

Sub-tabs

Setpoint Explorer

Context Bar
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The 2100 expert software can be operated in six modes, called contexts”:

• Instrument Context

• Data Context

• Verification Context

• Comparison Context

• Assay Context

• System Context

NOTE
The contexts work independent from each other regarding their data. This means, for 
example, that you can review data and run measurements at the same time.
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Using the Contexts bar, the Context menu, or the selection list in the toolbar, you can 
switch between the contexts:

NOTE
Menus, toolbars, the tree view, and the main working area (tabs) significantly change 
when you switch between the contexts.

An introduction to the six contexts is given in the following.
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Instrument Context

On startup, 2100 expert enters the Instrument context, where you can run DNA, RNA, 
protein or cell assays by selecting an assay file and starting the chip run—provided that 
the bioanalyzer is properly connected, a chip is inserted, and the bioanalyzer lid is closed.
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NOTE
If two bioanalyzers are connected to your PC, you can run both in parallel. 

During the chip run(s), you can view the status of the bioanalyzer(s): instrument 
information and real time acquisition data. 

In the Instrument context, it is also possible to run hardware diagnostic tests on all 
connected bioanalyzers. Refer to “Running Instrument Diagnostics” on page 322 for 
details.
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Data Context

In the Data context, you can 

• view, analyze, and evaluate the results of your chip runs that are presented as 
electropherograms, gel-like images, histograms, dot plots, and result tables.

• export and print the results of your chip runs.

The measurement data is stored in .xad files.
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Verification Context

The Verification context is used to run and document qualification tests.

For both the bioanalyzer hardware and software tests can be run for:

• Installation verification

• System verification
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Verification results are automatically saved in .xvd files. You can re-open .xvd files to 
review verification results.

For details, refer to “Performing Verifications” on page 331.



Contents ▲ 41 ▼ Index

Comparison Context

In the Comparison context, you can open multiple electrophoretic chip data files and 
compare samples of the same assay class (DNA 1000, for example). It is possible to 
overlay electropherograms recorded by the bioanalyzer and compare the results. 

Comparison results can be saved in .xac files. You can re-open .xac files to review the 
comparison results and to add further samples for comparison.
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Assay Context

In the Assay context, you can create your own assays based on Agilent templates by 
modifying certain data (for example, data analysis setpoints). 

Assays are stored as .xsy files.
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System Context

In the System context, you can

• define System Wide Settings for the 2100 expert software such as settings for default 
file names and directories, signal colors, or auto export functions

• view the contents of the System Log Book
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Closing 2100 Expert

To close the 2100 expert software:

1 From the File menu, select Exit.

If a chip run is in progress, the following message appears:

Click OK and wait until the chip run is complete.

If there are unsaved files open, the following dialog box appears:
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NOTE
This dialog box may also appear if you try to switch between contexts while there is 
unsaved data. 

2 Click Yes to save the changes to the selected files and continue quitting 2100 expert.

If you want to save changes only to particular files, select these files in the list by 
single-clicking them. By default, all files with unsaved changes are selected.

If you click No, 2100 expert quits without saving any changes.

If you do not want to quit 2100 expert at this time, click Cancel to return to your 
2100 expert session without saving anything.

After you have confirmed the messages, 2100 expert quits.
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Running and Evaluating Electrophoretic Assays

For running and evaluating electrophoretic assays you need to know the following:

• “Principles of Nucleic Acid and Protein Analysis on a Chip” on page 47

• “Preparing and Running an Electrophoretic Assay” on page 51

• “Analyzing and Evaluating the Results of an Electrophoretic Assay” on page 82

• “Result Flagging” on page 157
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Principles of Nucleic Acid and Protein Analysis on a Chip

The electrophoretic assays are based on traditional gel electrophoresis principles that 
have been transferred to a chip format. The chip format dramatically reduces separation 
time as well as sample and reagent consumption. The system provides automated sizing 
and quantitation information in a digital format. On-chip gel electrophoresis is performed 
for the analysis of DNA, RNA and proteins.

The chip accommodates sample wells, gel wells and a well for an external standard 
(ladder). Micro-channels are fabricated in glass to create interconnected networks 
among these wells. During chip preparation, the micro-channels are filled with a sieving 
polymer and fluorescence dye. Once the wells and channels are filled, the chip becomes 
an integrated electrical circuit. The 16-pin electrodes of the cartridge are arranged so that 
they fit into the wells of the chip. Each electrode is connected to an independent power 
supply that provides maximum control and flexibility. Charged biomolecules like DNA, 
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RNA, or protein/LDS micells are electrophoretically driven by a voltage gradient—similar 
to slab gel electrophoresis. Because of a constant mass-to-charge ratio and the presence 
of a sieving polymer matrix, the molecules are separated by size. Smaller fragments are 
migrating faster than larger ones. Dye molecules intercalate into DNA or RNA strands or 
protein/LDS micells. These complexes are detected by laser-induced fluorescence. Data 
is translated into gel-like images (bands) and electropherograms (peaks). With the help 
of a ladder that contains components of known sizes, a standard curve of migration time 
versus fragments size is plotted. From the migration times measured for each fragment in 
the sample, the size is calculated. Two markers (for RNA only one marker) are run with 
each of the samples bracketing the overall sizing range. The “lower” and “upper” 
markers are internal standards used to align the ladder data with data from the sample 
wells. This is necessary to compensate for drift effects that may occur during the course 
of a chip run. 

For DNA and protein assays, quantitation is done with the help of the upper marker. The 
area under the upper marker peak is compared with the sample peak areas. Because the 
concentration of the upper marker is known, the concentration for each sample can be 
calculated. Besides this relative quantitation, an absolute quantitation is available for 
protein assays, using external standard proteins.

For RNA assays, quantitation is done with the help of the ladder area. The area under the 
ladder is compared with the sum of the sample peak areas. The area under the “lower” 
marker is not taken into consideration. For total RNA assays, the ribosomal ratio is 
determined, giving an indication on the integrity of the RNA sample. Additionally, the 
RNA integrity number (RIN) can be utilized to estimate the integrity of total RNA samples 
based on the entire electrophoretic trace of the RNA sample, including the presence or 
absence of degradation products. 
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The 2100 expert software plots fluorescence intensity versus size/migration time and 
produces an electropherogram for each sample:
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The data can also be displayed as a densitometry plot, creating a gel-like image:
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Preparing and Running an Electrophoretic Assay

An electrophoretic chip run requires the following steps:

1. Switch on the Agilent 2100 bioanalyzer and start the 2100 expert software.

See “Starting 2100 Expert” on page 32.

2. Select an electrophoretic assay.

See “Selecting an Electrophoretic Assay for a Chip Run” on page 52.

3. Prepare reagents, chip, and samples.

See “Preparing Samples, Reagents, and Chips for Electrophoretic Assays” on page 55 
and the appropriate Application Note or Reagent Kit Guide.

4. Load the chip into the bioanalyzer.

See “Loading the Electrophoresis Chip into the Bioanalyzer” on page 59.

5. Start the chip run.

See “Running an Electrophoretic Assay” on page 65.

When the chip run has finished, you can:

• Have a first look at the results (see “Displaying the Measurement Results 
(Electrophoresis)” on page 73). 

• Document the chip run (see “Entering Chip, Sample, and Study Information” on page 70). 

• Analyze and evaluate the results:

– See “Analyzing and Evaluating the Results of an Electrophoretic Assay” on page 82.

– See “Result Flagging” on page 157.
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Selecting an Electrophoretic Assay for a Chip Run

To select an assay:

1 Switch to the Instrument context.

2 In the Tree View Panel, select the bioanalyzer you want to use.

In the upper left of the Instrument tab, an icon shows the status of the bioanalyzer. You 
should see one of the following icons (lid open/closed), indicating that the bioanalyzer 
is detected by the system:

3 If you do not see one of these icons, check that the bioanalyzer is switched on and 
properly connected:

– Check the COM port setting.

– Make sure the bioanalyzer is physically connected to the PC (over the serial 
interface).

– Check the power connection.

– Check the power switch.
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If you need additional help, please refer to the Agilent 2100 Bioanalyzer Maintenance 
and Troubleshooting Guide.

4 Select an assay for the chip run.

On the Instrument tab, click the Assay button.

– OR – 

Click the Assays menu.

Both will open the Assays menu, allowing you to select an assay from the submenus.

– OR – 

Select File > Open File to Run. This opens a dialog box, allowing you to load either an 
assay (.xsy) or a chip data file (.xad).

The type of assay you have to select depends on the required measurement and the 
Reagent Kit you use to prepare your samples. Details on these assays are described in 
the Application Notes available for each assay and in the Reagent Kit Guide.

5 Select the desired assay, DNA 1000, for example.

The assay is loaded and its name appears on the Information Bar:

NOTE
After a chip run, the results can be evaluated using parameters from a different 
electrophoretic chip data file (.xad) of the same assay type (DNA 1000 in this example). 
Refer to “Importing Data Analysis Setpoints” on page 279.
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6 Select a Destination for the chip data file (.xad) that will be generated as the result of 
the chip run. You can also specify a custom File Prefix for this file.

7 Under Data Acquisition Parameters, enter the number of samples you want to have 
measured.

The total number of samples that can be measured varies with the type of assay 
selected. With DNA and RNA Nano assays, 12 samples may be run; with RNA Pico 
assays, 11 samples may be run; and with Protein assays, the maximum number of 
samples is 10. When preparing the chip (see “Preparing Samples, Reagents, and Chips 
for Electrophoretic Assays” on page 55), keep in mind that you have to follow the 
sequence of the sample wells. For example, if you want to measure only 3 samples, you 
have to fill the wells 1, 2, and 3 of your chip. 
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Preparing Samples, Reagents, and Chips for Electrophoretic Assays

Before you can load a chip, you have to prepare the samples and reagents. To find out 
how to prepare the samples and reagents, refer to the various Reagent Kit Guides 
available for each LabChip kit. Please refer to these documents for further information 
and analytical specifications.

In general, preparing an electrophoretic assay involves the following steps:

• Check that you have everything that is listed in the appropriate Reagent Kit Guide. 

Be aware that there can be small but important differences between the different 
assays even for the same type of molecules (for example, between DNA 1000 and DNA 
7500 assays).

• Make sure you are familiar with the essential measurement practices (see next page).

• Before running the first RNA assay: decontaminate the electrodes.

• Prepare all the reagent mixtures (for example, the gel-dye mix).

• Load the gel-dye mix using the priming station.

• Load the DNA/RNA marker solution and buffer.

• Load the destaining solution for protein assays.

• Load the chip with ladder and samples.
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Essential Measurement Practices (Electrophoretic Assays)

General:

WARNING
Wear hand and eye protection and follow good laboratory practices when preparing 
and handling reagents and samples.

WARNING
No data is available addressing the mutagenicity or toxicity of the dye/DMSO 
reagent. Because the dye binds to nucleic acids, it should be treated as a potential 
mutagen and used with appropriate care. The DMSO mixtures should be handled 
with particular caution as DMSO is known to facilitate the entry of organic 
molecules into tissues. We strongly recommend using double gloves when handling 
DMSO mixtures.

• Handle and store all reagents according to the instructions given in the Reagent Kit 
Guides.

• Avoid sources of dust or other contaminants. Foreign matter in reagents and samples 
or in the wells of the chip will interfere with assay results.

• Always insert the pipette tip to the bottom of the well when dispensing the liquid. 
Placing the pipette at the edge of the well may lead to poor results due to the formation 
of a bubble on the bottom of the well.
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• Protect dye and gel-dye mix from light. Remove light covers only when pipetting. Dye 
decomposes when exposed to light.

• Use a new syringe and electrode cleaner with each new LabChip kit.

• Do not touch the Agilent 2100 bioanalyzer during a chip run and never place it on a 
vibrating ground.

• Keep all reagents and reagent mixes refrigerated at 4 °C when not in use.

• Allow all reagents and samples to equilibrate to room temperature for 30 minutes 
before use.

• Use loaded chips within 5 minutes. Reagents might evaporate, leading to poor results. 

RNA Assays:

• Always wear gloves when handling RNA, and use RNase-free tips, microfuge tubes and 
water.

• It is recommended to denature all RNA samples and RNA ladder by heat before use 
(70 °C, 2 minutes).

• Always vortex the dye concentrate for 10 seconds before preparing the gel-dye mix.
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Protein Assays:

• Store Protein sample buffer at -20 °C upon arrival. Keep the vial in use at 4 °C to avoid 
freeze-thaw cycles.

• Allow the dye concentrate to equilibrate to room temperature for 20 minutes before 
use, to make sure the DMSO is completely thawed. Protect the dye from light during 
that time. Vortex before use.

• Allow all other reagents to equilibrate to room temperature for 10 minutes before use.

• Use 0.5 ml tubes to denature samples. Using larger tubes may lead to poor results, 
caused by evaporation.
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Loading the Electrophoresis Chip into the Bioanalyzer

The Agilent 2100 bioanalyzer uses different cartridges for electrophoretic and flow 
cytometric assays. For electrophoretic measurements, the electrode cartridge is required.

The electrode cartridge contains 16 electrodes that fit into the wells of DNA, RNA, and 
Protein chips. Each electrode in the cartridge has an individual power supply. All 
electrophoretic assays (DNA, RNA, and Protein) require an electrode cartridge. The 
electrode cartridges will either have an engraved “1” at the front, or will have no 
engraving at all. Cartridges with a different number are not electrode cartridges.
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If the bioanalyzer is set up for flow cytometric assays, but you want to run electrophoretic 
assays, proceed as follows:

1 Open the lid and pull down the metal locking lever into the open position as shown in 
the figure below. 

The cartridge is pushed out.

2 Gently pull the cartridge out of the lid.

NOTE
Store the pressure cartridge in the provided box.

Metal lever 
in open 
position
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3 Slide the electrode cartridge into the lid as shown below.

CAUTION
Do not touch the electrodes while the cartridge is in the Agilent 2100 bioanalyzer. The 
electrodes and the high voltage power supplies can be damaged.

4 Push the metal front of the cartridge to ensure a tight connection.

5 Push the metal locking lever into the flat (closed) position.

Metal lever

Push here to ensure 
tight connection
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To load the prepared chip into the Agilent 2100 bioanalyzer:

1 Open the lid and remove any chip.

2 Adjust the chip selector to position “1” as shown in the following figure.

These steps are required for inserting DNA, RNA, and Protein chips in the bioanalyzer.

Move chip 
selector in 
position “1”

To avoid using 
incompatible chips and 
cartridges, a chip selector 
is installed in the 
bioanalyzer. This ensures 
that the chip matches to 
the installed cartridge.
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CAUTION
Do not force the chip selector handle when a chip is inserted in the bioanalyzer. 

3 Place the prepared chip into the receptacle. 

The chip fits only one way. Do not force it into place.

4 Carefully close the lid. 

CAUTION
Do not force the lid closed. This may damage the cartridge. If the lid does not close 
completely, check that the cartridge and chip are inserted properly, and the chip 
selector is in the correct position.

Chip selector 
in position “1”

Chip
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When the chip is detected, the image on the Instrument tab changes to a chip.

If the chip is not detected, open and close the lid again.

NOTE
The displayed image depends on the assay selected in the software, not the type of 
chip inserted. If you would like to run a DNA chip but a protein chip appears, you have 
selected the wrong assay.

NOTE
If the AutoRun option is active, the chip run starts automatically once a chip has been 
detected and the lid has been closed.
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Running an Electrophoretic Assay

NOTE
You can stop a chip run at any time, for example, if errors occurred or if you are not 
satisfied with the quality of the measurement results that you can observe during the 
chip run. See “Stopping a Chip Run” on page 68.

Starting the Chip Run

When you have loaded the chip, you can start the chip run:

1 On the Instrument tab, click the Start button.

The chip run starts. The Raw Signals sub-tab shows an electropherogram of the currently 
measured sample. The name of the sample is displayed above the graph. The graph is a 
“live” plot of the migration time against fluorescence units (raw data, including 
background fluorescence, for example).
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The number of the sample that is currently being measured is indicated on the 
information bar:

The status bar at the bottom of the screen shows the measurement progress for the chip 
run and the COM port number used for data acquisition.



Contents ▲ 67 ▼ Index

During the chip run, you can do the following:

• View the chip data file in the Data context by clicking on the name of the Data File:

• Switch to any other context. For example, you can evaluate any chip data file in the Data 
context, or compare samples in the Comparison context.

• If necessary, abort the chip run by clicking on the Stop button.

All data that was collected up to the stop point will be saved.

After the chip run is completed, you can:

• Switch to the Data context, where you can view, analyze, and evaluate the results of 
your chip run (see “Displaying the Measurement Results (Electrophoresis)” on page 73 
and “Analyzing and Evaluating the Results of an Electrophoretic Assay” on page 82).

• Stay in the Instrument context and start a new assay, for example.
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Stopping a Chip Run

You can stop a chip run at any time, for example, 

• if the quality of the measurement results does not meet your expectations,

• if, for example, after three samples you already have the information you desired and 
you want to start another chip run.

NOTE
You cannot resume a stopped chip run.

NOTE
If you stop a chip run, automatic export (see “Exporting Chip Run Data Automatically” 
on page 286) and automatic print (see “How to Turn on and Configure Automatic 
Printing of Chip Run Reports” on page 297) does not take place.

To stop the assay:

1 Click the Stop button.

– OR –

Select Stop from the Instrument menu.
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NOTE
Data acquisition of the current sample will be aborted.

The following message appears:

2 Click Yes to stop the chip run.

When the chip run is aborted, you can:

• Switch to the Data context, where you can view, analyze, and evaluate the results (if 
any) of your chip run (see “Displaying the Measurement Results (Electrophoresis)” on 
page 73 and “Analyzing and Evaluating the Results of an Electrophoretic Assay” on 
page 82).

• Stay in the Instrument context, where you can start the next chip run, for example.
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Entering Chip, Sample, and Study Information

During or after a chip run, you can document the run by entering information on chip, 
samples, and study.

1 In the Data context, select the Chip Summary tab.

2 On the Sample Information sub-tab, you can enter additional information such as 
sample names and comments. 

On the Study Information sub-tab, you can enter information such as the name of the 
current study, the laboratory location, and the experimenter, for example.
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NOTE
You may find some input fields already filled in, because chip, sample, and study 
information are taken over from the base assay or chip data file. 
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3 From the File menu, select Save.

T IP
You can import chip, sample, and study information from .txt or .csv files. This is 
especially helpful and time-saving, if you already have documented a similar chip run 
in another chip data file. Refer to “Importing Chip, Sample, and Study Information” on 
page 281 for details.
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Displaying the Measurement Results (Electrophoresis)

You can view the measurement results of an electrophoretic chip run as 
electropherograms or gel-like images. 

• You can display the electropherograms either one sample at a time, or all samples at 
the same time to get an overview of the chip run, for example, to see the progress of a 
reaction. See “How to Switch Between Single View and Grid View 
(Electropherograms)” on page 74.

• You can navigate through the samples. See “How to Navigate Through the Samples” on 
page 75.

• You can change the display of electropherograms and gel-like images to make details 
better visible. See “How to Change the Display of Electropherograms and Gel-like 
Images” on page 76.
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How to Switch Between Single View and Grid View (Electropherograms)

To switch between single view and grid view:

From the Electropherogram menu, select View Single Sample or View All Samples.

– OR –

Click the View Single Sample  or View All Samples  button on the 
Electropherogram toolbar.

– OR –

Click the All Samples entry in the Tree View Panel to switch to the grid view, or any 
sample name to switch to the single view.

– OR –

Double-click any electropherogram the grid view to switch to single view:
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How to Navigate Through the Samples

At any time—even during a chip run—you can scroll through all samples—either in 
electropherogram or gel view.

To navigate through samples using the Tree View Panel:

1 If the tree view is not visible, select View > Tree View. 

The tree view panel appears to the left of the tabs, and shows all chip data and assay 
files as nodes. 

2 Click any sample name.

Electropherogram view: the electropherogram of the selected sample is shown in 
single view

Gel view: the lane of the gel-like image corresponding to the selected sample is 
highlighted.

To navigate through samples using the Lower Panel:

1 If the lower panel is not visible, select View > Lower panel. 

The lower panel appears in the lower left corner.

2 Electropherogram view: Click any lane of the small gel image.
Gel view: Click any well on the chip icon.
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To browse through samples:

1 From the Electropherogram or Gel menu, select Next Sample or Previous Sample.

– OR –

Click the Next Sample  or Previous Sample  button in the toolbar.

To switch between electropherogram and gel view:

1 Click the Electropherogram or Gel tab to display the results of the selected sample as 
an electropherogram or as a gel-like image.

How to Change the Display of Electropherograms and Gel-like Images

It is possible to change the display of electropherograms and gel-like images.

In electropherograms and gel-like images you can:

• zoom (enlarge or reduce using the mouse) the graphs to display details, for example.

In electropherograms, you can additionally:

• show data points.

• pan and scale the graph using the mouse.

• change the background from a gray-to-white gradient to white.

• add a grid to the electropherograms.

In gel-like images, you can additionally:

• change the gel color.

• change order of gel lanes in gel like images.
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To zoom into an electropherogram:

1 From the Electropherogram menu, select Graph Mode > Zoom (default setting). 

2 Position the mouse pointer in the electropherogram.

3 Click and hold down the left mouse button.

The mouse pointer changes its shape to a magnifying glass .

4 Drag the mouse. 

A rectangle shows the part of the an electropherogram to be enlarged.

5 Release the mouse button.
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To pan and scale an electropherogram:

1 From the Electropherogram menu, select Graph Mode > Pan or Scale. 

2 Position the mouse pointer in the electropherogram.

3 Click and hold down the left mouse button.

The mouse pointer changes its shape to a double-arrow or to a double crosshair.

4 Drag the mouse. 

As you drag the mouse, the electropherogram curve moves in the drag direction (Pan 
mode), or the scales of the X and/or Y axes change (Scale mode).

5 Release the mouse button.

You can perform several zoom, pan and scale steps in a row.

To undo the last zoom, pan, or scale step:

Click the Undo Zoom  button or double-click in the electropherogram.

To undo all zoom, pan, and scale steps:

Click the Undo All  button.
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To display data points in an electropherogram:

From the Electropherogram menu, select Show Data Points or click the  button in the 
toolbar.

Data points used to generate the graph are now shown as bullets. Data points are 0.05 
seconds apart.

To remove the gray-to-white gradient from the background of an electropherogram:

From the Electropherogram menu, select Show Gradient.

The color gradient disappears and a white background is displayed.

To show/hide the grid lines on an electropherogram:

From the Electropherogram menu, select Show Grid.
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Cleaning the Electrodes after an Electrophoretic Assay

When the assay is complete, remove the used chip from the bioanalyzer and dispose of it 
according to the guidelines established by your laboratory safety officer. Remove the chip 
quickly to prevent a buildup of residues from the solutions on the electrodes.

Then perform the cleaning procedure to ensure that the electrodes are clean (i.e., no 
residues left from the previous assay). The cleaning procedures are described in detail in 
the appropriate Reagent Kit Guide and in the Agilent 2100 Bioanalyzer Maintenance and 
Troubleshooting Guide.
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Good Practices

• Empty and refill the electrode cleaner at regular intervals (e.g., every five assays).

• The electrode cleaner can be used for 25 assays.

CAUTION
Never use a cloth to clean the electrodes. Electrostatic discharge could damage the 
high-voltage power supplies.

CAUTION
Wet electrodes can cause severe damage to the on-board high voltage power 
supplies. Always make sure the electrodes are dry before inserting them into the 
bioanalyzer again.
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Analyzing and Evaluating the Results of an Electrophoretic Assay

The purpose of electrophoretic assays is to separate sample components and determine 
their size, concentration, purity, or molarity. Results for a particular sample are calculated 
after all data for that sample has been read.

The steps in data analysis differ depending on the type of assay in use:

• “Data Analysis: DNA” on page 83

• “Data Analysis: RNA and Cy5-Labeled Nucleic Acids” on page 88

• “The RNA Integrity Number (RIN)” on page 91

• “Data Analysis: Protein” on page 105

• “Smear Analysis” on page 113

Further steps in analysis are:

• “Changing the Data Analysis” on page 117

• “Manual Integration” on page 136

• “Reanalyzing a Chip Data File” on page 146

• “Comparing Samples from Different Electrophoretic Chip Runs” on page 148

• “How to Use the Form Mode” on page 164
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Data Analysis: DNA

The data analysis process for DNA assays consists of the following steps:

1. Raw data is read and stored by the system for all of the individual samples.

2. The data is filtered and the resulting electropherograms of all samples are plotted. You 
can change the settings of the data analysis after the run and reanalyze your data.

3. Peaks are identified for all samples and are tabulated by peak ID. You can change the 
settings of the peak find algorithm and reanalyze the data after the run has finished. 
(Note that peak find settings can be changed for all or only certain samples.)
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4. A sizing ladder (see the following example electropherogram), which is a mixture of 
DNA fragments of known sizes, is run first from the ladder well. The concentrations and 
sizes of the individual base pairs are preset in the assay and cannot be changed.

 

5. A standard curve of migration time versus DNA size is plotted from the DNA sizing 
ladder by interpolation between the individual DNA fragment size/migration points. 
The standard curve derived from the data of the ladder well should resemble the one 
shown below.
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6. Two DNA fragments are run with each of the samples, bracketing the DNA sizing range. 
The “lower marker” and “upper marker” are internal standards used to align the ladder 
data with data from the sample wells. The figure below shows an example of assigned 
marker peaks in a sample well.

NOTE
The software performs alignment by default. Turning automatic data analysis off 
suspends data analysis until you turn it on again.

7. The standard curve, in conjunction with the markers, is used to calculate DNA fragment 
sizes for each sample from the migration times measured.

Lower marker
Upper marker
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8. To calculate the concentration of the individual DNA fragments in all sample wells, the 
upper marker, in conjunction with an assay-specific concentration against base-pair 
size calibration curve, is applied to the individual sample peaks in all sample wells.

NOTE
The software allows you to redefine the peaks chosen as upper and lower markers. A 
change in marker selection will cause quantitative changes in the calibration 
procedure, however, and therefore in the entire data evaluation.

9. If the check box Rest. Digest on the Chip Summary Tab is enabled, the 2100 expert 
software flags peaks that may have co-migrated:

Since it is assumed that the molarity of all the fragments in a restriction digest should 
be the same, any peaks or clusters having a molarity that is significantly larger than the 
rest are flagged as potentially co-migrating peaks, allowing you to examine them in 
more detail.
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Data Analysis: RNA and Cy5-Labeled Nucleic Acids

The data analysis process for RNA and the Cy5-labeled nucleic acids assays consists of 
the following steps:

1. Raw data is read and stored by the system for all of the individual samples.

2. The data is filtered and the resulting electropherograms of all samples are plotted. You 
can change the settings of the data analysis after the run and reanalyze your data.

3. Fragments are identified for all samples and tabulated by peak ID. You can change the 
settings of the peak find algorithm for any or all samples and reanalyze the data.

4. An RNA ladder (containing a mixture of RNA of known concentration) is run first (see 
the electropherogram below). The concentrations and sizes of the individual base pairs 
are preset in the assay and cannot be changed.

Electropherogram of RNA 6000 Ladder (Ambion, Inc. cat. no. 7152)
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NOTE
Peak ratios for the RNA ladder may vary from one batch of RNA 6000 ladder to the 
next. Assay performance will not be affected by this variation.

5. For the Eukaryote or Prokaryote Total RNA assay, the RNA fragments (either 18S and 
28S for eukaryotic RNA or 16S and 23S for prokaryotic RNA) are detected. After 
detection, the ratio of the fragment areas is calculated and displayed.

 

6. To calculate the concentration of the RNA, the area under the entire RNA 
electropherogram is determined. The ladder, which provides the concentration/area 
ratio, is applied to transform the area values into concentration values.
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Alignment of RNA Samples

The marker solution that is part of each RNA LabChip kit, contains a 50 bp DNA fragment. 
This fragment is used as lower marker to align all samples.

By default the RNA alignment and the subtraction of the lower marker are enabled for 
RNA Nano assays.

The marker is displayed as the first peak in the electropherogram.
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The RNA Integrity Number (RIN)

The RNA integrity number (RIN) is a tool designed to help scientists estimate the 
integrity of total RNA samples. The RIN extension automatically assigns an integrity 
number to a eukaryote total RNA sample analyzed on the Agilent 2100 bioanalyzer. Using 
this tool, sample integrity is no longer determined by the ratio of the ribosomal bands 
alone, but by the entire electrophoretic trace of the RNA sample, including the presence 
or absence of degradation products. In this way, interpretation of an electropherogram is 
facilitated, comparison of samples is enabled and repeatability of experiments is 
ensured.

Scope

What the RIN can do:

• Obtain an assessment of the integrity of RNA.

• Directly compare RNA samples (e.g. before and after shipment, compare integrity of 
same tissue across different labs, etc.).

• Ensure repeatability of experiments (e.g. if RIN shows a given value and is suitable for 
microarray experiments, then the RIN of the same value can always be used for 
microarray experiments given that the same organism/tissue/extraction method was 
used).

What it cannot do:

• Tell a scientist ahead of time whether an experiment will work or not if no prior 
verification was done (e.g. RIN of 5 might not work for microarray experiments, but 
might work well for an appropriate RT-PCR experiment. Also, an RIN that might be good 
for a 3' amplification might not work for a 5' amplification).
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The computation of the RIN is part of data analysis for total RNA samples. The computed 
RNA integrity number is shown on the Results sub-tab of the Gel or Electropherogram 
tab of the Data context. It is also included in XML export files and in printed reports.
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NOTE
Until now, the computation of the RIN has only been validated for eukaryote total RNA 
Nano samples. The 2100 expert software also calculates the RIN for prokaryote total 
RNA samples and for the RNA 6000 Pico assay. Be aware that for these samples, the 
RIN has not been validated in extensive downstream experiments.

Although the lower quantitative limit of the RNA 6000 Nano assay is specified as 25 
ng/µl it is recommended to use at least 50 ng/µl for a meaningful RNA integrity number. 
When using lower concentrations, higher sample to sample variances of the RIN may be 
observed.

Examples for RNA Integrity Numbers

A database of about 1300 mammalian total RNA samples was created using the RNA 
6000 Nano assay. The samples came from different species (mainly human, rat and 
mouse), tissues, preparation methods, concentrations and degradation states. All 
samples were classified according to their degradation state. Numbers from ’1’ to ’10’ 
were used as labels. ’10’ stands for a perfect RNA sample without any degradation 
products, whereas ’1’ marks a completely degraded sample. The labels in-between are 
used to indicate progressing degradation states of the RNA sample. The following figure 
shows typical representatives for each of the 10 RNA integrity classes.
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RIN: 1 RIN: 2

RIN: 3 RIN: 4
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RIN: 7 RIN: 8

RIN: 6RIN: 5
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RIN: 10RIN: 9
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Computation of the RNA Integrity Number and Signal Anomalies

For the computation or the RNA integrity number, the electropherogram is partitioned 
into regions as shown in the figure below. The lower marker and the 18S and 28S 
fragments divide the electropherogram into nine regions:

Signal Anomalies

In addition to the computation of the RIN, the data analysis detects various unexpected 
signals, disturbing the computation of the RIN. Such disturbances are called anomalies. 
Region anomaly detectors recognize unexpected signals in each region. If detected, the 
anomaly is displayed in the Error sub-tab of the Electropherogram and Gel tab. 

pre-region

marker

5S-region

fast-region

18S-fragment

inter-region
28S-fragment

precursor-region

post-region
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Two categories of anomalies were introduced, critical and non-critical. Anomalies in 
regions interfering with the customer sample RNA are considered critical. The 
corresponding gel lane is flagged red. 

The baseline anomaly, for example, is detected for signals with fluctuating or steep 
baseline. The ribosomal ratio anomaly detects unexpected ratios of the 28S fragment 
area and the 18S fragment area. The unexpected sample type anomaly is detected for 
samples which do not fit the standard total RNA profile. 

Anomaly Description Critical?

Unexpected baseline signal Yes

Unexpected signal in pre-region No

Unexpected signal in 5S-region Yes

Unexpected signal in fast-region Yes

Unexpected signal in inter-region Yes

Unexpected signal in precursor-region No

Unexpected signal in post-region No

Unexpected ribosomal ratio Yes

Unexpected sample type Yes

Unexpected lower marker (compared to previous well) No
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If a non-critical anomaly is detected, the RIN can still be computed accurately. Therefore 
non-critical anomalies are not flagged. Non-critical region anomalies are pre-region 
anomaly, precursor-region anomaly and post-region anomaly. The electropherogram 
below gives an example for a non-critical anomaly in the post-region.
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Troubleshooting the RIN

To obtain meaningful and reproducible results, the lower marker and ribosomal bands 
must be identified correctly. Although the ribosomal fragment identification has been 
improved, in rare cases (i.e. when analyzing degraded RNA samples) the fragment 
baseline is not properly set. In this case the user should adjust the baseline settings 
manually.

Example:

’Incorrect’ software identification of the ribosomal fragments: RIN=7.2
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RNA integrity number after the manual adjustment: RIN=5.7

On details on how to adjust the lower marker and ribosomal bands, please refer to 
“Changing the Data Analysis” on page 117.
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Use Models for the RNA Integrity Number

To take full advantage of the RIN feature, a 2 step use-model is suggested:

1 Determine the threshold value for the RIN that results in meaningful downstream 
experiments:

Cells/Culture

RIN

Isolation of total RNA

RNA QC via
Agilent 2100 bioanalyzer

Correlate RIN with downstream experiment and determine threshold RIN 
for meaningful results (iterative process)
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2 Run standard experiment and use RIN to determine if sample integrity is sufficient:

Cells/Culture

RIN

Isolation of total RNA

RNA-QC via
Agilent 2100 bioanalyzer

 RIN above threshold

Continue with downstream experiment (microarray, real-time PCR, etc.)

RIN
below 
threshold
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RNA Integrity Number Setpoints

Various setpoints are available to customize the display of the RIN (RNA Integrity 
Number). With these setpoints, you can modify the predefined thresholds for anomaly 
detection. You can find them in the advanced user mode of the setpoint explorer.

To adjust the setpoints for a single sample, switch to the Local tab of the setpoint 
explorer and open the RNA Integrity Number group.

To adjust the setpoints for the whole chip, switch to the Global tab of the setpoint 
explorer and open the RNA Integrity Number group in the Sample Setpoints group. For 
the chip, you can additionally switch between integer and decimal representation of the 
RIN.

For more information on how to use the setpoint explorer, see “About the Setpoint 
Explorer” on page 118.
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Data Analysis: Protein

The data analysis process for protein assays consists of the following steps:

1. Raw data is read and stored by the system for all of the individual samples.

2. The data is filtered and the resulting electropherograms of all samples are plotted. You 
can change the settings of the data analysis after the run and reanalyze your data.

3. Peaks are identified for all samples and are tabulated by peak ID. You can change the 
settings of the peak find algorithm and reanalyze the data after the run has finished. 
(Note that peak find settings can be changed for all or only certain samples.)
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4. A sizing ladder (see the example electropherogram below), which is a mixture of 
proteins of different known sizes, is run first from the ladder well. The sizes of the 
individual proteins are preset as kDa in the assay and cannot be changed. Please note 
that the concentrations may vary slightly from ladder lot to ladder lot.
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5. A standard curve of migration time versus size is plotted from the sizing ladder by 
interpolation between the individual protein size/migration points. The standard curve 
derived from the data of the ladder well should resemble the one shown below.
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6. Two proteins are run with each of the samples, bracketing the sizing range. The “lower 
marker” and “upper marker” proteins are internal standards used to align the ladder 
data with data from the sample wells. The figure below shows an example of assigned 
marker peaks in a sample well.

NOTE
The software performs alignment by default. Turning automatic data analysis off 
suspends analysis until you turn it on again.

Lower marker

Upper marker
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7. The standard curve, in conjunction with the markers, is used to calculate protein sizes 
for each sample from the migration times measured.

8. To calculate the concentration of the individual proteins in all sample wells, the upper 
marker is applied to the individual sample peaks in all sample wells.

NOTE
The software allows you to define upper and lower markers yourself. A change in the 
selection of the markers will lead to quantitative changes in the calibration procedure, 
however, and therefore in the entire data evaluation.
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Protein Absolute Quantitation

Absolute quantitation is calculated based on the relative concentration of a sample and 
the user-defined standard and the known concentration of this user-defined standard. 

For protein samples you can enable the use of calibration for each sample and enter the 
concentration of the standard protein. This allows you to generate a calibration curve, 
which can be used to analyze and quantitate this protein within different samples on the 
same chip.

Using Calibration in Protein Assays 

The calibration feature for protein assays allows absolute quantitation based on external 
standard calibration. 

On the Chip Summary tab, use the sample table on the Sample Information sub-tab to 
define the samples that you want to use as calibration standards and enter a 
concentration. 
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The calibration standard should be run in different concentrations to generate a 
calibration curve. The software will automatically produce this calibration curve based on 
these inputs to determine the actual concentration of samples within the same chip. In 
the peak tables of the samples, a remark is added to the observation column to identify 
the calibration protein and the calibrated proteins:
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The calibration curve can be displayed by switching to the Calibration Curve sub-tab on 
the Chip Summary tab. 
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Smear Analysis

The 2100 expert software allows to perform a smear analysis for all electrophoresis 
assays. 

When the smear analysis is enabled, the software allows you to define regions of 
interest. These regions are used to define the area of broad peaks and determine their 
part of the total area. Smear analysis provide a means to analyze broad signals that can 
be hardly evaluated with the normal peak assignment. 

You therefore can define regions of interest that contain the peaks (base pair size) that 
you are interested in. For these regions you can determine the covered area in relation to 
the total area.

Enabling Smear Analysis

To enable smear analysis:

1 Go to the Electropherogram tab in the Data context:

2 Go to the setpoint explorer and select the Local or Global tab, depending on which 
samples should be analyzed.

3 Select the Advanced mode.
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4 Under Smear Analysis, select the check box Perform Smear Analysis.

The Region Table sub-tab is added to the Electropherogram tab.
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Performing Smear Analysis

After enabling the smear analysis in the setpoint explorer, you are able to insert regions 
of interest in the electropherogram. 

To do so:

1 Select the Region Table sub-tab in the Electropherogram tab.

2 Right-click the electropherogram and select Add region.

A region will be inserted into the electropherogram. The Region Table shows the values 
for the inserted region.

3 Repeat the previous step until the number of required regions is inserted. 

4 Adjust the regions by directly moving the dashed lines in the electropherogram.

5 To remove a region, right-click the dashed line in the electropherogram and select 
Remove Region from the context menu.

NOTE
The smear analysis table can be directly edited by selecting the region table under 
Smear Analysis in the setpoint explorer.
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In the smear analysis table, you can edit the Region Start Size and Region End Size, for 
example:
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Changing the Data Analysis

Different sets of parameters (data analysis setpoints) can be changed in the software in 
order to modify the data evaluation for sample analysis:

• Filtering parameters

• Peak find parameters for all samples/peak height for individual samples

• Enabling smear analysis

• Align to upper and/or lower marker

• Adding/deleting ribosomal fragments (for RNA assays only)

• Manual integration (for protein and DNA assays only)

• Absolute quantitation (for protein assays only)

These settings can be made before a new run is started or when reanalyzing a previously 
saved data file.
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About the Setpoint Explorer

The tool allowing you to modify the data analysis setpoints is the Setpoint Explorer. The 
setpoint explorer is accessible from:

• Assay Properties Tab

• Electropherogram Tab (Single/Grid View)

• Gel Tab
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On the Assay Properties tab, the setpoint explorer is always visible and lets you modify 
setpoints globally (for all samples):
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To show the setpoint explorer, on the Electropherogram/Gel tab, click the vertical bar on 
the right edge of the application window:

The setpoint explorer appears.

For electrophoretic assays, you can modify the setpoints 

• globally, that is, for all samples (Global tab)

• locally, for the current sample (Local tab)

Click the + nodes to expand, and the – nodes to collapse branches. Setpoints that you 
can change are white. To edit a setpoint, double-click the value, enter the new value, and 
press enter. They are applied automatically.
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When you try to change any global setpoints where local settings have been applied, the 
software prompts you as to whether you want to overwrite the local (custom) settings.

If you decide to overwrite the custom sample settings, all local settings you made will be 
discarded. If you decide not to overwrite the custom sample settings, the global settings 
will not be applied where local settings have been changed.
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Color Coding of Setpoint Values

Specific color coding indicates differences between local setpoint values and global 
setpoint values. The following differences are indicated:

• One local setpoint value differs from the global setpoint value as defined for this assay.

On the Local tab, a yellow background indicates that a local setpoint value has been 
modified and differs from the current global setpoint value.

A tooltip displays the global default value originally defined for this assay. 

Right-click the local setpoint value to access the following functions:

Copy to Clipboard: The current local setpoint value is copied to the clipboard.

Restore Default: The local setpoint value is reset to the setpoint value as currently 
defined on the Global tab.

Set as Default: The local setpoint value is set as new global setpoint value, but not 
automatically applied to all other samples.
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On the Global tab, the corresponding global setpoint value for which a local setpoint 
value has been modified is displayed in blue font color.

A tooltip displays the corresponding local values of all samples in sequential order. 

• Local setpoint values differ from the global values as preset by Agilent but match the 
global setpoints as currently defined for this assay.

On the Global tab, a yellow background indicates that the global setpoint value differs 
from the value as preset by Agilent but all local setpoints have the same value as the 
current global value.
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A tooltip displays the global value as preset by Agilent.

• Local setpoint values differ from the global values as preset by Agilent as well as from 
the global setpoints as currently defined for this assay.

On the Global tab, a blue font color on yellow background indicates that the global 
setpoint value differs from the global setpoint values as preset by Agilent and at least 
one local setpoint value.
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Right-click the global setpoint value to access the following functions:

Copy to Clipboard: The current global setpoint value is copied to the clipboard.

Apply to All: The current global setpoint will be applied to all samples and override their 
current value.

Restore Default: The current global setpoint will be reset to default as preset by Agilent, 
but will not override current local setpoint values.
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Filtering Setpoints

The first step the software takes in analyzing the raw data is to apply data filtering. The 
following filtering setpoints can be changed: 

Integrator Setpoints

After data filtering, the peak find algorithm locates the peaks and calculates the local 
peak baselines. The algorithm begins by finding all the peaks above the noise threshold 
in order to determine the baseline, after which any peaks below the noise threshold are 
rejected. A local baseline is calculated for each peak to allow for baseline drift.

Filter Width Defines the data window, given in seconds, used for averaging. The 
broader the filter width, the more raw data points are used for 
averaging. As a result, the noise level will decrease, but peaks will 
become lower and broader. Overall, changing the Filter Width has 
more effect on the result of the filtering procedure applied then 
does changing the Polynomial Order.

Polynomial Order This setting is used to define the power series applied to fit the raw 
data. The higher the number, the more the fit function will follow 
the noisy raw data curve. As a result, the noise level of the filtered 
curve will increase.
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The integrator setpoints that can be changed are:

Slope Threshold The Slope Threshold setpoint determines the difference in the 
slope that must occur in order for a peak to begin. The inverse of 
this value is used to determine the peak end.

Area Threshold The Area Threshold determines the minimum amount of peak area 
that must be detected before a peak is recognized.

Height Threshold The Height Threshold setpoint determines whether a peak is kept. 
It represents the minimal peak height. For each peak, the difference 
between the start point value and the center point value (local 
baseline) must be greater than the Height Threshold value.

Peak Filter Width The Peak Filter Width setpoint determines the minimum amount of 
time that must elapse before a peak is recognized.

Baseline Plateau The Baseline Plateau setpoint is a parameter that assists in finding 
peaks. The signal is recognized to be at baseline whenever the 
slope of the data is less than the Slope Threshold setpoint (either 
positive or negative) for longer than the time set for the Baseline 
Plateau. This setting rejects brief, low slope areas such as between 
non-baseline-resolved peaks.
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Manually Moving Fragment Start and End Points (RNA and Cy5-Labeled Nucleic 
Acids)

It is also possible to alter the start and end points manually for individual fragments in an 
RNA or Cy5-labeled nucleic acids assay. The integration borders of detected 
RNA-fragments are displayed in the Fragment Table sub-tab. Zooming in on the base of a 
particular fragment allows you to see the start and end points. Placing the cursor over 
one of these points changes the cursor to a pointing hand, allowing you to click and drag 
the point along the line of the fragment until it is positioned as desired. 

 

Move any other start or end points as desired.
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TIP
The fragment table can be directly edited in the setpoint explorer:

NOTE
Changing the start or end points of the fragment will change the calculated rRNA ratio. 
It might be convenient to pause the automatic analysis (Electropherogram > Pause 
Automatic Analysis) until all changes are done. 

Setting the Baseline for Calculation of RNA Concentration

At low signal-to-noise ratios, the baseline that defines the area used for calculating the 
concentration of RNA assays is highly dependent on the settings for the Start and End 
Time. You can adjust the Start and End Times manually (thereby adjusting the baseline) 
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to ensure a good result even at very low signal-to-noise ratios. Choose a single sample. 
Two vertical green long-dashed lines indicating the setpoints for the Start and End Times 
(with the baseline drawn between them) are displayed in the window.

Move the cursor over the long-dashed line on the left (Start Time setting) and drag the 
line to the desired position. Do the same with the long-dashed line on the right (End Time 
setting) until you have a flat baseline.

NOTE
Changing the start and end times will change the calculated RNA concentration. It 
might be convenient to pause the automatic analysis (Electropherogram > Pause 
Automatic Analysis) until all changes are done. 
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Assigning Upper and Lower Marker Peaks

For each DNA or protein sample, the upper and lower marker peaks are assigned first and 
then the data is aligned so that the sample markers match the ladder markers in time, 
allowing the size and concentration of the sample peaks to be determined. RNA samples 
are aligned to a lower marker exclusively.

The first peak is assigned to be the lower marker and is then offset to match the lower 
marker in the ladder. The upper marker is then assigned to the last peak in the sample 
well or to the peak nearest the ladder’s upper marker. See an example of assigned 
marker peaks below.

If you get unexpected peaks in the ladder analysis or find that the markers have been set 
incorrectly, you may exclude peaks manually from the ladder or set a peak to be used as a 
marker. Right-clicking in the peak table causes a context menu to appear, allowing you to 
do so:
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In case the 2100 expert software did not detect the lower marker in RNA samples 
correctly, you are able to manually assign it in the same way.

CAUTION
Excluding a peak or manually setting a peak to be an upper or lower marker may cause 
errors during analysis.
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Aligning or Unaligning the Marker Peaks

The upper and lower are then aligned to the ladder markers by resampling the sample 
data in a linear stretch or compression using a point-to-point fit.

Data before alignment:
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Markers aligned to the ladder:

If the sample marker peaks are either more than twice as far apart or less than half as far 
apart as the ladder markers, they are assumed to be the wrong peaks, and analysis of the 
sample stops, producing the error “Marker peaks not detected”.
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NOTE
With DNA and protein assays, the height of marker peaks is assay dependent. Ladder 
peaks are analyzed to calculate a marker peak threshold that is used to locate the 
marker peaks in the sample wells. If the marker peaks found using this calculated 
method fail to align with those of a sample, the 2100 expert software will use the 
minimum peak height threshold setting instead (if this value is lower than the value for 
the marker peak). For example, the calculated threshold might be too high to find the 
sample's markers if they happen to be very small for some reason. Either no markers 
will be found or the wrong peaks will be assumed to be markers and these may not 
align with the ladder markers. Consequently, the software attempts to use the 
minimum peak height threshold that, if it is set low enough, will catch the real 
markers, allowing the sample to align.

NOTE
After alignment, peaks are shown with relative migration times that are different from 
the real times with data unaligned.
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Manual Integration

For DNA and Protein assays, the 2100 expert software allows to manually integrate 
peaks. Manual integration allows you to move, add or delete peak baselines. 

T IP
To move a peak baseline, point along the vertical line, press the CTRL key and left 
mouse button. To move a peak baseline, point along the signal, press the left mouse 
button only.

Example: Adjusting peak baselines

To manually change peak baselines:

1 Switch to the Electropherogram tab in the Data context and zoom into the 
electropherogram to enlarge the peak of interest.

2 Select Electropherogram > Manual Integration to switch off the automatic integration.

As an alternative you can click the Manual Integration button  in the toolbar. 
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The baseline points become visible as blue or green dots. Highlighted baseline points 
are labelled green and can be moved either along the vertical line (press CTRL key and 
left mouse button) or along the signal trace (left mouse button). The blue baseline 
points are fixed and cannot be moved. To highlight a baseline point, click it.

T IP
If you want to change several baseline points, deactivate the automatic analysis by 

clicking the Pause Analysis button  in the toolbar. This way, the software will not 
recalculate the data analysis with every change. Once you have changed all baseline 
points, click the Pause Analysis button again to activate automatic analysis.
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3 Adjust the baseline points as appropriate.

T IP
To move a peak baseline point along the vertical line, press the CTRL key and the left 
mouse button. To move a peak baseline point along the signal, press the left mouse 
button only.

4 Click the Automatic Analysis button  to enable the integration again. 

The integration results in the result and peak tables will change according to the 
changes done.
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Example: Removing peaks

To remove peaks:

1 Highlight the Electropherogram tab in the Data context and zoom into the 
electropherogram to enlarge the peak of interest.

2 Select Electropherogram > Manual Integration to switch off the automatic integration. 
As an alternative you might click the Manual Integration button  in the toolbar. The 
baseline points become visible as blue or green dots.
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3 Right-click a baseline-point and select Remove Peak from the context menu. 

The two baseline points and the connecting line will disappear and the integration 
results shown in the result and peak tables will be updated:
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Example: Inserting peak baselines

To insert peaks manually:

1 Highlight the Electropherogram tab in the Data context and zoom into the 
electropherogram to enlarge the peak of interest.
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2 Right-click the electropherogram and select Add Peak from the context menu.
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3 Two baseline points and the connecting line will appear and the integration results 
shown in the result and peak tables will be updated.
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TIP
If you want to change several baseline points, deactivate the automatic analysis by 

clicking the Pause Analysis button  in the toolbar. This way, the software will not 
recalculate the data analysis with every change. Once you have changed all baseline 
points, click the Pause Analysis button again to activate automatic analysis.

4 Adjust the baseline points as appropriate.

T IP
To move a peak baseline point along the vertical line, press the CTRL key and the left 
mouse button. To move a peak baseline point along the signal, press the left mouse 
button only.
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5 Click the Automatic Analysis button  to enable the integration again. 

The integration results in the result and peak tables will change according to the 
changes done.
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Reanalyzing a Chip Data File

NOTE
Occasionally you may wish to open and view or reanalyze a chip data file that was run 
and saved previously. The raw data values are saved in the data file, along with the 
analysis settings that were chosen for the run, so that the data can be reanalyzed with 
different settings.

To do this: 

1 Click File > Open to open a chip data file (.xad).

2. Choose the filename from the list of data files.

3. Click OK. 

The items that can be changed for reanalysis are:

All Electrophoresis Assays:

• Global peak find settings

• Individual sample peak find settings

• Gel color

• Sample names and comments

RNA Assays Only:

• Fragment names and colors associated with labels

• Fragment start/end times, additional fragments (or delete fragments found)
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• Reassign lower marker

DNA and Protein Assays Only:

• Exclude peaks from analysis

• Reassign upper/lower markers

• Alignment or no alignment with marker peaks

• Manual integration

Protein Assays Only:

• Absolute quantitation

TIP
When applying modified data analysis setpoints, the software will (by default) 
immediately recalculate the raw data, which takes some time. Select Don’t Analyze 
from the Gel Menu or Electropherogram Menu to temporarily switch off automatic 
data analysis while you modify setpoints.

If you save the data file after making changes, it will keep a record of the changes such 
as gel color, sample names, and peak find settings that were in effect at the time the file 
is resaved. If you do not want to change the original file, choose File > Save As… and give 
the file a new name or save it to a different location.
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Comparing Samples from Different Electrophoretic Chip Runs

The 2100 expert software allows you to compare the measurement results of samples 
from different electrophoretic chip runs. Samples to be compared must be from chip runs 
of the same assay type. 

In the Comparison context, you can create comparison files, include samples from 
different chip runs, and compare the samples by overlaying electropherograms, for 
example. 

To compare samples from different electrophoretic chip runs:

1 Switch to the Comparison context.

2 From the File menu select Open, and open all chip data files (.xad) that contain the 
samples you want to compare.

The .xad files appear in the Select Data Files list of the Tree View Panel.

NOTE
The Select Data Files list also contains all electrophoretic .xad files that are currently 
open in the Data context.
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3 Select a .xad file from the Select Data Files list to display a list of its samples.

4 Right-click a sample name and select Add Sample to New Comparison File.
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A new comparison file appears in the upper part of the tree view containing the sample. 
The sample is selected and its electropherogram is shown.

Note that the Electropherogram Tab (Single/Grid View) has the same functionality as 
in the Data context.
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5 You can now add further samples from any of the open .xad files to the comparison file.

T IP
Double-clicking a sample name in the lower part of the tree view or dragging a sample 
name into the tree view adds the sample to the comparison file that is currently 
selected in the upper part of the tree view. Or, if no comparison file is selected, creates 
a new comparison file and adds the sample to it.

You are notified if you try to add a sample of a .xad file that has the wrong assay type.
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6 You can also remove samples from a comparison file. Right-click the sample name and 
select Delete Sample from Comparison File.
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7 When you have added all your samples, you can select the Comparison Summary Tab 
which displays information on the comparison file, and lets you enter a comment 
regarding the comparison.
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8 To compare the electropherograms of samples, go to the Electropherogram tab, click 
Overlaid Samples in the toolbar, and select the samples to be compared.
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9 Select the Gel tab to display a comparison of the gel-like images of the samples.

Note that the Gel Tab has the same functionality as in the Data context.
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10From the File menu, select Save to save the comparison file (.xac) under the default 
name, or select Save As to save it under a new name.

The default name is derived from the assay class: “ComparisonFileX [Assay Class].xac” 
where “X” is an autoincremented number. Example: “ComparisonFile0 Protein 200.xac”

NOTE
You can re-open comparison files to review the comparison results, and to 
add/remove samples.
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Result Flagging

Result flagging can be used to assign a user-defined color code to a sample. This lets you 
easily identify samples with certain properties immediately after a chip run.

The color assignment is carried out by applying a sequence of rules to the measurement 
results obtained for the sample. The rules are defined on chip level and are applied to all 
samples of the chip. 

Two modes are available to define result flagging rules: 

• Form Mode 

In this mode, you can easily compose an expression by selecting functions and 
operators from given lists. If necessary, additional attributes have to be provided.

By selecting a logical operator (AND/AND NOT/OR/OR NOT), further terms can be 
combined to form a more complex expression. The last term of the expression ends 
with the operator NONE.

• Editor Mode

This mode is more flexible and allows you to write arbitrary complex expressions by 
using functions, variables and operators.

T IP
You can export result flagging rules and import rules from other assay or chip data 
files. See “Exporting Result Flagging Rules” on page 291 and “Importing Result 
Flagging Rules” on page 282.
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Regardless of how you create the result flagging rules, there are two options available for 
the order in which the rules are applied:

• In Normal mode, the rules are applied in the given order, and the first matching rule will 
determine the color of the sample. All rules are applied subsequently. The first rule 
which applies to the sample defines its color. So you should start with the most specific 
rule. If that one does not apply, a less specific one may apply. If none of the defined rules 
apply, the final default rule defines the color code.

• In Target mode, all rules are applied subsequently. If the next rule applies, the color 
code changes to the color code defined by the rule, otherwise the previous color code 
is kept. Therefore, the last matching rule defines the color code of the sample. This 
mode is called target mode because later rules refine the result color code. The first 
default color code is the most general and the last one the most specific.

You can define the flagging rules already in the assay, or—after the chip run is 
finished—modify these rules or define new rules in the chip data file, and apply the rules 
to the measurement results. Defined rules can also be saved, loaded and applied to other 
data files.
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TIP
The examples shown in this chapter are taken from the demo assay “Demo Protein 
200 Plus.xsy”, that comes with the 2100 expert software. You can find this demo assay 
in the “..\assays\demo\electrophoresis” subdirectory of the 2100 expert installation 
folder. 
In the “..\data\samples\resultflagging” subdirectory of the 2100 expert installation 
folder, you can find further examples for result flagging rules (.xml), which you can 
import in the “Protein 200 Plus” demo assay.
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Defining Result Flagging Rules

The rules can be defined on the Result Flagging tab. This tab is available in the Data 
context if an electrophoretic chip data (.xad.) file is selected and in the Assay context if 
an electrophoretic assay (.xsy) file is selected.
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A result flagging rule consists of the following:

• Label Expression

An optional description for the rule used to label samples meeting this rule.

• If Expression

An expression built from predefined functions, variables, and logical operators.

• Comment

An optional comment for the rule.

• Color Expression

A solid color or a color gradient built from two colors, used for flagging samples that 
meet the rule.

“How to Use the Form Mode” on page 164 shows how to proceed when defining rules.

You can reuse result flagging rule definitions, see “Exporting Result Flagging Rules” on 
page 291 and “Importing Result Flagging Rules” on page 282.
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Color Indication

The results of the result flagging rules is displayed:

• On the Chip Summary Tab:

The colors in the Result Flagging column show which sample matches which rule.
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• On the Gel Tab:

The spot on top of the lane is colored if the sample matches a result flagging rule.

• On the small gel image on the Lower Panel:
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• On the Results tab:

Result Flagging Color: color of the result flagging rule that the current sample matches.

Result Flagging Label: label of the result flagging rule that the current sample matches.

How to Use the Form Mode

The Form Mode provides some pre-defined rules (forms) that you can use to define the 
result flagging rules to color-code your samples. You can set up any number of rules for 
evaluation. As a typical example of how these forms are used, you can use the form mode 
to flag DNA samples that have a fragment purity of 10% for fragment sizes of 150 bp. 

To do this, proceed as follows: 

1 Open the job that contains the results to be analyzed in the Data context and switch to 
the Result Flagging tab. 

2 Switch to the form mode by clicking the Switch to Form Mode icon . 

3 Choose the Search Fragment with Purity form from the Select Form selection list. 



Contents ▲ 165 ▼ Index

The Search Fragment with Purity form is displayed. 

4 Define the fragment size(s) to be searched for. 

5 Define the required purity for the fragment size(s) and the tolerance. 

6 If you defined several fragment sizes and want all of these to be present in the flagged 
samples, select the option All of them must be present. If you only require that one of 
the sizes is present, select the option Any of them can be present. 

Fragment/
protein list

Tolerance

Labels and color 
definitions

Logic operation

Purity



Contents ▲ 166 ▼ Index

7 Select the color with which the samples that meet the criteria should be marked. 

8 Optionally select the color with which samples that do not meet the criteria should be 
marked. 

9 Apply this rule to the samples by clicking the Apply Result Flagging icon . 

All samples are re-evaluated according to the result flagging rule and displayed with the 
respective colors. See “Color Indication” on page 162 for more information on the color 
codes.

Additional information is available in the Help panel at the bottom of the screen. This 
panel provides context-specific help, including examples. 

How to Use the Editor Mode

The editor mode for result flagging is a powerful way of creating your own result flagging 
rules. 

To define a result flagging rule for a selected job:

1 Open the job in question in the Data context and switch to the Result Flagging tab.

2 Switch to the editor mode by clicking the Switch to Editor Mode icon .

3 Edit a rule that was created within the form mode.

–OR–

Create a new rule by clicking the Add icon  or Duplicate Selected Rule icon .

4 Click the Edit button next to the Rule Label field and enter the result label for this rule. 
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The result label can be any arbitrary text or be a logic expression. Expressions are built 
up of functions, variables, operators, and values. You can manually type in the 
expressions. But you can also double-click the items in the Functions, Variables, and 
Operators lists, to insert them in the respective fields.

For example, defining the result label as "Number of peaks is" + NumberOfPeaks() 
returns Number of peaks is 10, if the sample contains ten peaks.

Detailed descriptions of the available functions as well as the required syntax and 
examples are shown in the Help field at the bottom of the screen.

NOTE
If the entered syntax is not correct, the invalid part is displayed in red color.

5 Click the Edit button next to the Rule Condition field and enter the logic expression for 
this rule. 

As an example for a logic expression for the rule condition, enter NumberOfPeaks() > 
9 AND PeakFoundAuto(150). With this rule, all samples can be found that have more 
than nine peaks while one of them is located at 150 bp +/- 10%.

6 Click the Edit button next to the Rule Comment field and enter a comment for this rule.

7 Click the Edit button next to the Rule Color field and select a color for the rule. If you 
check the Gradient check box, you can assign a color gradient to the rule. This allows 
to imply further information in the displayed results.
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For example, the rule condition NumberOfPeaks() > 0 marks all samples with peaks. 
If you want to indicate the actual number of peaks with the color code, you need to 
enter NumberOfPeaks() in the Rule Color field. Then you define light green for the 
Minimum Value 1 and dark green for 10 peaks as the Maximum Value. As a result, a 
darker green will be displayed for samples with more peaks. 

8 If necessary, generate additional rules. Rearrange the order of the rules with the Move 
Selected Rule Up and Move Selected Rule Down icons.

9 To apply the rules to your measurement results, click the Apply Result Flagging icon .

If there still are syntax errors in the rule definitions, an error message appears.

All samples are re-evaluated according to the result flagging rules and displayed with 
the respective colors. See “Color Indication” on page 162 for more information on the 
color codes.
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Example: Result Flagging

Sample 1 contains 100 µg/ml proteins. The electropherogram shows 2 peaks for 2 
different proteins, which could be separated. One peak can be found at 32 kDa (LDH). 

Sample 2 contains 60 µg/ml proteins and shows 3 peaks.

Sample 3 contains 80 µg/ml proteins and shows 5 peaks.

Now, the following rules are defined:

1. Is there a peak at 30 kDa +/- 7%?

Rule 1: PeakFound(30, PER, 7)

2. Is the total concentration of proteins higher than 90 µg/ml?

Rule 2: TotalConcentration() > 90

3. Were 5 to 10 peaks found?

Rule 3: NumberOfPeaks() >= 5 AND NumberOfPeaks <= 10 

Alternative Rule 3: NumberOfPeaks() BETWEEN (5,10)

Applying these rules in the given order (in Normal mode) leads to the following results: 



Contents ▲ 170 ▼ Index

For sample 1, rule 1 matches and defines the color. Rule 2 would also match, but is not 
checked, because the procedure stops at the first match.

For sample 2, none of the rules match, if there is no peak at 30 kDa +/- 7%. Therefore, 
this sample will get the default color.

For sample 3, only rule 3 matches and defines the color.
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Running and Evaluating Flow Cytometric Assays

For running and evaluating flow cytometric assays, you need to know the following:

• “Principles of Flow Cytometric Measurements” on page 172

• “Overview of Flow Cytometric Assays” on page 181

• “Preparing and Running a Flow Cytometric Assay” on page 184

• “Analyzing and Evaluating the Results of a Flow Cytometric Assay” on page 217
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Principles of Flow Cytometric Measurements

Besides electrophoretic assays (DNA, RNA, and proteins), the Agilent 2100 bioanalyzer 
supports flow cytometric assays:

• First, cells are stained with two fluorescent dyes that correspond to biologically 
relevant parameters, as described in the application notes available for each assay. 
“Staining Cells” on page 173 explains the principle.

• Next, the stained cells are analyzed on the chip. They pass the detector in single file and 
are analyzed individually for their red and blue fluorescence intensities. The results are 
displayed as histograms or dot plots. Refer to “Cell Detection with the Agilent 2100 
Bioanalyzer” on page 175 for a detailed explanation.
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Staining Cells

With the 2100 expert software, you can differentiate several properties of a cell. The 
characteristics that are examined depend on the dye, which binds specifically to a 
cellular constituent or is metabolized by the cell to generate a fluorescent product. You 
usually use two dyes with different colors. Typically, one of the two dyes is used as 
reference dye to select the target cells (living/dead, cell line type, etc.). The second dye 
can be used to detect another characteristic of the cell.

Recommended dyes

The tables below list dyes that match to the detection optics specification (Excitation 
max: 470 & 630 nm; Emission max: 525 & 680 nm).

The following dyes are recommended for use as the blue stain:

Dye (blue fluorescence) Max. Excitation 
wavelength

Max. Emission 
wavelength

Calcein (living cell stain) 493 nm 514 nm

Cell Tracker green (cell tracing, 
viability stain) 

492 nm 517 nm

GFP (green fluorescent protein) 490 nm 510 nm

SYTO16 (DNA dye) 485 nm 530 nm
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The following dyes are recommended for use as the red stain:

Dye (red fluorescence) Max. Excitation 
wavelength

Max. Emission 
wavelength

CBNF (Carboxynaphthofluorescein, 
living cell stain)

595 nm 675 nm

APC (Allophycocyanin, intra- and 
extra cellular antibody staining)

650 nm 660 nm

Cy5 (labeled Streptavidin and 
labeled anti-IgG, Apoptosis, 
intra- and extra-cellular antibody 
staining)

647 nm 665 nm

Alexa 647 650 nm 668 nm
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Cell Detection with the Agilent 2100 Bioanalyzer

LabChip technology allows cell measurements by integrating cell flow, hydrodynamic 
focusing, and fluorescence detection into a microfluidic chip. A cell suspension can be 
confined or “pinched” to a portion of a microfluidic channel, causing cells to line up in 
single file for individual cell detection. The following images illustrate the pinching 
process.

Up to six cell samples can be analyzed on a chip. They are measured sequentially.

Cell Buffer

Cells Detector

Buffer well

Sample well

Pinching area
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Measuring Events

The bioanalyzer counts cells stained with fluorescent dyes and measures their 
fluorescence intensities. Each cell or bead that passes the detector and emits 
fluorescence above a threshold value is counted as an event. For each event, the 
intensity of two different fluorescent signals (red and blue) is recorded. The intensity of 
the fluorescent signal depends on the amount of stain bound to the cell (and therefore a 
specific cell property) and the physical properties of the stain itself.

The Agilent 2100 bioanalyzer lets you determine the number of cells characterized by a 
specific pattern of fluorescence.

For example, to differentiate between dead and living cells, you can use a 
non-fluorescent dye that becomes fluorescent when metabolized by living cells. After 
staining with such a dye, living cells have a higher fluorescence value than dead cells. 
The second dye could bind to a specific surface marker on a subpopulation of the cells. 
This allows you to determine the number of living cells that contain your marker of 
interest.

For evaluation, 2100 expert displays the results as histograms and as dot plots.
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Generating Histograms

2100 expert counts the events, sorts them and displays them according to their 
fluorescence intensity in histograms. For each color measured, a histogram displays the 
number of events related to the fluorescence intensity. A large number of events with a 
high fluorescence value means that a large number of cells containing the fluorescence 
dye were detected.

In the following illustration, cells which fluoresce in both colors are highlighted.

As a cell passes through the detector, its blue and red fluorescence values 
are measured and the count is increased for both channels at the 
appropriate intensity.

Illustrates a cell that 
fluoresces in blue and 
red. The height of the 
bars is related to the 
number of cells with this 
fluorescence value.



Contents ▲ 178 ▼ Index

In the histograms, the bar chart is replaced by a point-to-point line as shown in the 
following image.

For detailed information, see “Using Histograms for Evaluation” on page 218.
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Generating Dot Plots

Single events can also be displayed related to both fluorescence values, generating a 
map of dot plots. In dot plot view, the events (cells with a minimum fluorescence 
intensity) are displayed in a coordinate system (logarithmic axis scaling). Each axis 
represents a fluorescence color. A high number of events (cells) with similar 
fluorescence values are displayed as a dense cluster of dots, as shown in the following 
image.

To determine the number of cells whose blue and red fluorescence lies within a defined 
range, you can insert regions. Additionally, a gate can be set for either red or blue 
fluorescence to obtain percent values on a defined population.

As a cell passes through the detector, its blue 
and red fluorescence values are measured.
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In predefined assays, the borders of the rectangular region represent the markers defined 
in the corresponding blue and red histograms. 

The lower left region of a dot plot usually shows no events, due to the defined peak 
detection threshold that the fluorescence values must exceed.

For detailed information, see “Using Dot Plots for Evaluation” on page 239.

Gate
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Overview of Flow Cytometric Assays

The cell characteristic to be measured requires not only specific dyes. Several 
measurement parameters to control the measurement and the data acquisition 
parameters also have to be specified. These so-called “setpoints” are stored in assay 
files (.xsy) and are read by the 2100 expert software before it starts the measurement.

2100 expert supports the following assays based on flow cytometry:

Predefined assays

• Apoptosis

• Apoptosis – fast protocol

For reduced background, this assay has an increased threshold and uses blue events 
only for peak detection.

• Antibody Staining

• On-chip Antibody Staining

For reduced background, this assay has an increased threshold in the blue signal.

• GFP

• On-chip GFP

This assay allows a rapid and accurate detection of green fluorescent protein 
expression.

• Blue to red

This assay is for applications that apply a blue reference dye and analyze red 
fluorescent cells within a blue population.
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• Red to blue

This assay is for applications that apply a red reference dye and analyze blue 
fluorescent cells within a red population.

• Checkout Beads

Red checkout beads are loaded into the wells 1, 3 and 5 and blue checkout beads into 
the wells 2, 4 and 6. Markers are set according to expected fluorescence levels of the 
red and blue beads. The Checkout Beads assay has the properties of a generic assay 
(see below).

• siRNA Transfection Viability

Transfection Viability analysis as described in the Application Note: siRNA transfection 
optimization with the Agilent 2100 bioanalyzer (Agilent publication number: 
5988-9782EN). This assay enables the automatic calculation of transfection efficiency 
(TE) in histogram view and viability in transfected cells (ViT) in dot plot view. Required 
gating directions and regions are provided as example, but can be adjusted. Final 
Transfection Viability (TV) can be calculated by multiplication TE and ViT values derived 
from histograms and dot plots.

The settings of predefined assays are optimized to measure the appropriate cell 
characteristics. For evaluation, it is only necessary to adjust the markers in histograms or 
regions in dot plots.

Predefined assays contain all necessary markers and regions for evaluation. The gating 
direction for histograms is given (for details on the gating direction, refer to “Gating” on 
page 220). The markers in all samples are connected (changing a marker changes the 
corresponding markers in all samples).
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The regions of the dot plots are related to the markers of the histograms. Thus, the 
results of the dot plots are identical to the results of the histograms. 

Generic assay

This assay has no specific settings and can be used to define individual assays. You can 
freely add markers or regions, and define the gating direction.

The generic assay is recommended for chips with different samples and stainings, where 
regions would need to be defined individually. Dot plot and histogram regions are not 
linked, making it possible to evaluate an individual sample with different settings.

Flow cytometry assay icons

On the Assay Properties tab, the following icons are used to visualize the assay type:

Antibody Staining
Blue to Red

Apoptosis GFP
Red to Blue

Generic
Checkout Beads
siRNA Transfection 
Viability



Contents ▲ 184 ▼ Index

Preparing and Running a Flow Cytometric Assay

A flow cytometric chip run requires the following steps:

1. Switch on the Agilent 2100 bioanalyzer and start the 2100 expert software.

Details are given in “Starting 2100 Expert” on page 32.

2. Select a flow cytometric assay.

See “Selecting a Flow Cytometric Assay for a Chip Run” on page 186.

3. Prepare chip and samples.

Refer to “Preparing Samples and Chips for Flow Cytometric Assays” on page 190 and 
to the appropriate Application Note and Reagent Kit Guide.

4. Load the chip into the bioanalyzer.

For details refer to “Loading the Cell Chip into the Bioanalyzer” on page 194.

5. Start the chip run.

This is described in “Running a Flow Cytometric Assay” on page 201.

When the chip run has finished, you can:

• Have a first look at the results (see “Displaying the Measurement Results (Flow 
Cytometry)” on page 210). 

• Document the chip run (see “Entering Chip, Sample, and Study Information” on 
page 207). 
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• Analyze and evaluate the results:

– “Using Histograms for Evaluation” on page 218

– “Using Dot Plots for Evaluation” on page 239

– “Evaluating Antibody Staining, Apoptosis, and GFP Assays” on page 248
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Selecting a Flow Cytometric Assay for a Chip Run

To select an assay:

1 Switch to the Instrument context.

2 In the Tree View Panel, select the bioanalyzer you want to use.

In the upper left of the Instrument tab, an icon shows the status of the bioanalyzer. You 
should see one of the following icons (lid open/closed), indicating that the bioanalyzer 
is detected by the system:

3 If you do not see one of these icons, check that the bioanalyzer is switched on and 
properly connected:

– Check the COM port setting.

– Make sure the bioanalyzer is physically connected to the PC (over the serial 
interface).

– Check the power connection.

– Check the power switch.
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If you need additional help, please refer to the Agilent 2100 Bioanalyzer Maintenance 
and Troubleshooting Guide.

4 Select an assay for the chip run.

On the Instrument tab, click the Assay button.

– OR – 

Click the Assays menu.

Both will open the Assays menu, allowing you to select an assay from the submenus.

Note that you can also select File > Open File to Run. This opens a dialog box, allowing 
you to load either an assay (.xsy) or a chip data file (.xad).

The type of assay you have to select depends on the experiment and the staining 
protocol you use to prepare your cell samples. Details on these assays are described in 
the Application Notes available for each assay.

5 Select the desired assay, for example, Apoptosis.

The assay is loaded and its name appears on the Information Bar:

NOTE
After a chip run, the results can be evaluated using a different flow cytometric chip 
data or assay file. Refer to “Importing Data Analysis Setpoints” on page 279.
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6 Select a Destination for the chip data file (.xad) that will be generated as the result of 
the chip run. You can also specify a custom File Prefix for this file.

7 If required, change the Data Acquisition Parameters:

a Enter the number of samples you want to be measured.

When preparing the chip (see “Preparing Samples and Chips for Flow Cytometric 
Assays” on page 190), keep in mind that you have to follow the sequence of the 
sample wells. For example, if you want to measure 3 samples, you have to fill the 
wells 1, 2, and 3 with your samples, and the remaining wells with cell buffer solution.
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b Select the Data Acquisition Mode.

Select Default, if you want the measurement time to be set to the default value 
(240 s/sample). The maximum time is shown in brackets.

– OR –

Select Fixed time and enter the time in [s] that the measurement of each sample is 
to take.

– OR –

Select Number of Cells and enter the minimum number of events that should be 
measured. In the  and no longer than field, enter the maximum time in [s] a 
measurement can take, regardless of whether or not the defined number of events is 
reached. The maximum time is shown in brackets.

NOTE
The overall run time for a chip is limited to 1440 s. The individual run time for one 
sample depends on the number of samples that are measured per chip. If only one 
sample is measured, you can set the run time up to 1440 s.
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Preparing Samples and Chips for Flow Cytometric Assays

WARNING
Several substances such as dyes can have toxic, carcinogenic, or mutagenic 
potential. Therefore, carefully follow the safety instructions from the dye safety data 
sheet and the Reagent Kit Guides. Also read the “Essential Measurement Practices 
(Flow Cytometric Assays)” on page 192.

Before you can fill a chip, you have to prepare the samples. To find out which protocols 
you should use to prepare the samples, refer to the various Application Notes available 
for each assay.

Sample and chip preparation is described in detail in the Reagent Kit Guide available for 
each LabChip kit.
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Chip Reagents

Several reagents have to be added to the chip to prepare it for measurement. The 
following image shows which reagents have to be filled in which wells.

Make sure you follow these directions when preparing the sample:

• The priming solution has to be added first. It fills all channels (removes all air from the 
micro channels).

• The focusing dye is used to adjust the optic. The optics are focused horizontally and 
vertically before each chip is measured.

• If you do not use all six wells, always load the first sample in well 1, the second sample 
in well 2 etc. Unused wells have to be filled with cell buffer solution, otherwise they may 
run dry during the chip run. Because all channels are connected to the priming well, this 
may led to bubbles and to a clogging of the pressure adapter filter.

• The cell buffer is used to focus the cells before they pass the detection point. You have 
to fill both buffer wells with cell buffer.

Priming solution

Cell buffer

Sample 1 – 6
Cell buffer

Focusing dye 
solution
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Essential Measurement Practices (Flow Cytometric Assays)

• Handle and store all reagents according to the instructions given in the Reagent Kit 
Guides.

• Avoid sources of dust or other contaminants. Foreign matter in reagents and samples 
or in the wells of the chip will interfere with assay results.

• Store all reagent and reagent mixes in the dark and refrigerated at 4 °C when not in use.

• Allow all reagents to equilibrate to room temperature for 30 minutes before use.

• Protect focusing dye from light. The dye decomposes when exposed to light.

• Use appropriate pipette tips. For each pipetting step use a fresh, new pipette tip.

• Always insert the pipette tip to the bottom of the well when dispensing the liquid. 
Placing the pipette at the edge of the well may lead to poor results due to the formation 
of a bubble on the bottom of the well.

• For chip preparation, use inverse pipetting.

• When filling the pipette tip, push slightly over the first resistance. Empty the pipette tip 
only to the first resistance. This procedure avoids the introduction of bubbles and 
ensures pipetting the right volume.

• Never leave any wells empty, or the pressure adapter may become clogged. Pipette 
10 µl of cell buffer or sample replicate in any empty sample well.
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• Before bead preparation, vortex bead vials for 15 seconds.

• Prepared chips must be used within 5 minutes. If a chip is not run within 5 minutes, 
beads may settle or reagents may evaporate, leading to poor results.

• Never touch the instrument lens.

• Never touch the Agilent 2100 bioanalyzer during a chip run and never place it on a 
vibrating ground.
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Loading the Cell Chip into the Bioanalyzer

The Agilent 2100 bioanalyzer uses different cartridges for electrophoretic and flow 
cytometric assays. For flow cytometric measurements, the pressure cartridge is required.

The pressure cartridge contains a tubing and filter assembly that connect to the vacuum 
pump. The seal has to match the priming well on the chip so that the required low 
pressure can be built up. The pressure cartridge can be identified by the engraved 
number “2” on the front.

NOTE
Any cartridges without engraved numbers are electrode cartridges.
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If the bioanalyzer is set up for electrophoretic assays, but you want to run flow cytometric 
assays, proceed as follows:

1 Open the lid and pull down the metal locking lever in the open position as shown in the 
following figure.

CAUTION
Do not touch the electrodes while the cartridge is in the Agilent 2100 bioanalyzer. The 
electrodes and the high voltage power supplies can be damaged.

The cartridge is pushed out.

Metal lever 
in open 
position
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2 Gently pull the cartridge out of the lid.

CAUTION
Improper handling of the electrode cartridge will damage it.
Always store the electrode cartridge in the provided box. If the pins of the electrode 
cartridge are bent or misaligned, poor quality results or pre-terminated chip runs will 
result.

3 Slide the pressure cartridge in the lid as shown in the following figure.

4 Push the metal front of the cartridge until it is securely in place.

5 Push the metal locking lever in the flat (closed) position.

Metal lever

Push here to ensure 
tight connection
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To load the prepared chip into the Agilent 2100 bioanalyzer:

1 Open the lid and remove any chip.

2 Adjust the chip selector to position “2” as shown in the following figure. 

This will allow you to insert cell chips in the bioanalyzer.

Move chip 
selector in 
position “2”

To avoid using 
incompatible chips and 
cartridges, a chip selector 
is installed in the 
bioanalyzer. This ensures 
that the chip matches to 
the installed cartridge.
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CAUTION
Do not force the chip selector handle when a chip is inserted in the bioanalyzer. 

3 Place the prepared chip into the receptacle. 

The chip fits only one way. Do not use force.

Chip selector 
in position “2”

Cell chip
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4 Carefully close the lid. 

CAUTION
Do not force the lid closed. This can damage the pressure cartridge. If the lid does not 
close without force, check that chip is inserted correctly and that the chip selector is 
at the correct position for this chip type.
When the software recognizes an inserted chip, the chip is shown on the Instrument 
tab. If you have closed the lid, and the software has not recognized the chip, verify that 
the cartridge and chip are inserted properly and the chip selector is in the correct 
position. Close the lid.

The adapter with the gasket in the cartridge fits onto the priming well of the chip. A 
small gap between the lid and the instrument mainframe is normal and no cause for 
malfunction. The icon on the Instrument tab changes to a cell chip icon:

If the chip is not detected, open and close the lid again.
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NOTE
If the AutoRun option is active, the chip run starts automatically once a chip has been 
inserted and the lid has been closed.
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Running a Flow Cytometric Assay

Running a flow cytometric assay in 2100 expert just means pressing a button.

NOTE
You can stop a chip run at any time, for example, if errors occurred, or if you are not 
satisfied with the quality of the measurement results, which you can observe during 
the chip run. See “Stopping a Chip Run” on page 205.

Starting the Chip Run

When you have loaded the chip, you can start the chip run:

1 On the Instrument tab, click the Start button.
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The chip run starts. The Dot Plot sub-tab shows single events (cells) as they are 
detected, displayed as dots. In the coordinate system, the red and blue fluorescence 
intensity of each event can be read. The name of the currently measured sample is 
displayed above the graph.
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The number of the sample that is currently being measured is indicated on the 
information bar:

The status bar at the bottom of the screen shows the measurement progress for the chip 
run and the COM port number used for data acquisition.

During the chip run, you can do the following:

• View the chip data file in the Data context by clicking on the name of the Data File:

• Evaluate any chip data file in the Data context.

• Compare samples in the Comparison context.

• If necessary, abort the chip run by clicking on the Stop button (see also “Stopping a Chip 
Run” on page 205). 

All data that was collected up to the stop point will be saved.
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After the chip run is completed, you can:

• Switch to the Data context, where you can view, analyze, and evaluate the results of 
your chip run (see “Displaying the Measurement Results (Flow Cytometry)” on 
page 210 and “Analyzing and Evaluating the Results of a Flow Cytometric Assay” on 
page 217).

• Stay in the Instrument context, where you can start a new chip run, for example.
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Stopping a Chip Run

You can stop a chip run at any time, for example, 

• if the quality of the measurement results does not meet your expectations,

• if, for example, after three samples you already have the information you desired and 
you want to start another chip run.

NOTE
You cannot resume a stopped chip run.

NOTE
If you stop a chip run, automatic export (see “Exporting Chip Run Data Automatically” 
on page 286) and automatic print (see “How to Turn on and Configure Automatic 
Printing of Chip Run Reports” on page 297) does not take place.

To stop the assay:

1 Click the Stop button. 

– OR –

Select Stop from the Instrument menu.
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NOTE
Data acquisition of the current sample will be aborted.

The following message appears:

2 Click Yes to stop the chip run.

When the chip run is aborted, you can:

• Switch to the Data context, where you can view, analyze, and evaluate the results (if 
any) of your chip run (see “Displaying the Measurement Results (Flow Cytometry)” on 
page 210 and “Analyzing and Evaluating the Results of a Flow Cytometric Assay” on 
page 217).

• Stay in the Instrument context, where you can start the next chip run, for example.
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Entering Chip, Sample, and Study Information 

During or after a chip run, you can document the run by entering information on chip, 
samples, and study.

1 In the Data context, select the Chip Summary tab.

2 On the Sample Information sub-tab, you can enter additional information for samples, 
such as names for blue and red stain. 

On the Study Information sub-tab, you can enter information such as the name of the 
current study, the laboratory location, and the experimenter.
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NOTE
You may find some input fields already filled in, because chip, sample, and study 
information are taken over from the base assay or chip data file. 
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3 From the File menu, select Save.

T IP
You can import chip, sample, and study information from .txt or .csv files. This is 
especially helpful and time-saving, if you already have documented a similar chip run 
in another chip data file. Refer to “Importing Chip, Sample, and Study Information” on 
page 281 for details.
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Displaying the Measurement Results (Flow Cytometry)

You can view the measurement results of a flow cytometric chip run as histograms or dot 
plots. 

• You can display the histograms/dot plots either one sample at a time, or all samples at 
the same time to get an overview of the chip run, for example, to see the progress of a 
reaction. See “How to Switch Between Single View and Grid View” on page 211.

• You can navigate through the samples. See “How to Navigate Through the Samples” on 
page 212.

• You can change the display of histograms and dot plots to make details better visible. 
See “How to Change the Display of Histograms and Dot Plots” on page 214.
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How to Switch Between Single View and Grid View

To switch between single view and grid view:

From the Histogram or Dot Plot menu, select Single View or Grid View.

– OR –

Click the Single View  or Grid View  button on the histogram/dot plot toolbar.

– OR –

Click the All Samples entry in the Tree View Panel to switch to the grid view, or any 
sample to switch to the single view.

– OR –

Double-click any histogram or dot plot in the grid view to switch to single view.

The following example shows switching between grid view and single view for 
histograms.
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How to Navigate Through the Samples

At any time—even during a chip run—you can scroll though all samples—either in 
histogram or dot plot view.

To navigate through samples using the Tree View Panel:

1 If the tree view is not visible, select View > Tree View. 

The Tree View Panel appears to the left of the tabs, and shows all chip data and assay 
files as nodes. 

2 Click any sample name.

The histogram or dot plot of the sample is shown in single view.

To navigate through samples using the Lower Panel:

If the lower panel is not visible, select View > Lower panel. 

The lower panel appears in the lower left corner, showing a chip icon.
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3 Click any well on the chip icon.

To browse through samples:

From the Histogram or Dot Plot menu, select Next Sample or Previous Sample.

– OR –

Click the Next Sample  or Previous Sample  button in the histogram/dot plot 
toolbar.

To switch between histogram and dot plot view:

Click the Histogram or Dot Plot tab to display the results of the selected sample as a 
histogram or dot plot.
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How to Change the Display of Histograms and Dot Plots

In single view, it is possible to change the display of histograms and dot plots.

In histograms and dot plots you can:

• zoom (enlarge or reduce using the mouse) the graphs to display details, for example.

• put a color gradient on the background of the graphs.

In histograms, you can additionally:

• show data points.

To zoom into a histogram or dot plot:

1 Position the mouse pointer in the histogram/dot plot.

2 Click and hold down the left mouse button.

The mouse pointer changes its shape to a magnifying glass .

3 Drag the mouse. 

A rectangle shows the part of the histogram/dot plot to be enlarged.

4 Release the mouse button.
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You can perform several zoom steps in a row. When you have zoomed a histogram or dot 
plot, the Undo Zoom and Undo All buttons are enabled.

To undo one zoom step:

Click the Undo Zoom  button or double-click in the histogram or dot plot.

To undo all zoom steps:

Click the Undo Zoom All  button. 
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To display data points in histograms:

From the Histogram menu, select Show Data Points.

All events are shown as bullets.

To put a color gradient on the background of a histogram or dot plot:

From the Histogram or Dot Plot menu, select Gradient.

– OR –

Click the Gradient  button the histogram or dot plot toolbar.

A color gradient (gray to white) appears on the background of the graph.
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Analyzing and Evaluating the Results of a Flow Cytometric Assay

You can analyze and evaluate result data of flow cytometric assays using either the dot 
plot or the histogram view. In both views, you can evaluate the detected cells by defining 
areas of interest.

• Histograms show the distribution of events related to the red and blue fluorescence 
intensity. Gating is used to generate subsets based on markers in one histogram. See 
“Using Histograms for Evaluation” on page 218 for detailed information.

• Dot plots show events as dots in a coordinate system where the blue fluorescence 
value is related to the red. Regions and gates are used to determine the number of cells 
with a fluorescence intensity lying in a defined range. See “Using Dot Plots for 
Evaluation” on page 239 for detailed information.

If you use predefined assays, the markers and regions are set at the approximate position 
where the events are expected. Refer to “Evaluating Antibody Staining, Apoptosis, and 
GFP Assays” on page 248 for information on how to evaluate the predefined assays.

T IP
You can analyze and evaluate results while a chip run is still in progress.
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Using Histograms for Evaluation

Histograms are graphical representations of the measurement results, where the number 
of events (cells) is mapped to the Y axis and their fluorescence values to the X axis. The 
resulting curves show the frequency distribution of the events in relation to their 
fluorescence intensity values, as shown in the following image. In real histograms, the 
bin is reduced to a dot (data point).

The histograms can be evaluated statistically with markers that allow you to define 
ranges of fluorescence intensity values. One histogram can be used to represent a range 
of fluorescence values to define a subset of events. Only cells with a fluorescence value 
within this range are displayed in the second histogram. This method is called gating.

50 cells were detected with a 
fluorescence intensity between 
30 and 40
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Markers

Markers are used to define a range of fluorescence intensity values in a histogram. The 
upper and lower limits of the range are displayed as vertical lines, as shown in the 
following image.

The numerical values for each defined marker are displayed in a separate row in the 
result table. One marker is used as a gate for the second histogram, to define a subset of 
events.

In predefined assays, the markers are set by default and you only need to adjust their 
position. If you want to define your own assays, select the Generic assay for acquisition, 
where you can define your own markers and/or regions together with gates.

If you use several markers within one histogram, only one of them can be used for gating. 
The other markers can only be used to evaluate regions in the histogram they cover. The 
values belonging to these markers are also displayed in the result table.

Events (cells) of interest

Low intensity

Lower limit of the marker

Upper limit of the marker
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Gating

Gating is used to restrict the number of events that are evaluated by gating out (filtering) 
events that do not have the fluorescence values set by a marker. For example, by gating 
on a blue marker, you can exclude all events with low blue fluorescence (allowing you, 
for example, to gate out dead cells, unbound dye and debris). Only events with blue 
fluorescence values within the marker range are evaluated. Thereby, you can exclude any 
dead cells, and evaluate only the living cells for another property. 

The gating direction defines the reference histogram:

• Gating from blue to red uses the blue histogram to define the subset by a marker 
(Apoptosis and Antibody Staining assays).
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• Gating from red to blue uses the red histogram to define the subset by a marker 
(GFP assay).

NOTE
Predefined assays have a fixed gating direction, while assays of type Generic have a 
variable gating direction.
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The following figures illustrate gating from blue to red.

The two histograms display all measured events in the blue histogram and in the red 
histogram without gating. In this case, you cannot see which cells fluoresce only in the 
blue and which fluoresce only in the red. 

All events that show 
red fluorescence 

All events that show 
blue fluorescence 
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By setting a marker on the blue histogram, you can define the blue fluorescence range 
that must be met for a cell to be considered for the red histogram. You use the gating on 
the blue histogram to define a subset for the red histogram.

Subset of the events, 
defined by the marker

Events of the subset that 
show also red fluorescence
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The red histogram displays now only cells with blue and red fluorescence within the 
marker. To evaluate this subset, you can set a marker in the red histogram. This second 
marker filters out all cells that do not have fluorescence in this range.

The result table (see also “Displaying the Results of Histogram Evaluations” on page 236) 
of the gated histogram (here the red one) shows the values numerically:

• The % total value shows the number of events that have both high blue and high red 
fluorescence, in relation to all measured events.

• The % of gated value shows the number of events that have high blue and high red 
fluorescence in relation to the blue (or red) events.

Events that show both high 
blue and high red 
fluorescence

Events with high blue 
fluorescence
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The following image shows two histograms with a gating direction from blue to red (left 
to right) of an apoptosis assay. The blue histogram shows calcein fluorescence, which 
indicates living or dead cells (high fluorescence value means living cells). The red 
histogram shows the subpopulation of living cells with annexin V fluorescence indicating 
apoptosis (high fluorescence value means the cell is apoptotic). As a result you can see a 
subset of living, apoptotic cells.

Number of 
events

Fluorescence 
value

Histogram

Marker
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How to Insert a Marker in a Histogram

A marker is shown as two vertical lines that define a region of fluorescence values. It is 
used to select a subset of events according to this fluorescence region. 

NOTE
You can insert markers only in generic assays.

To add a new marker:

In the toolbar of the Histogram tab, click the Insert Marker button . 

A marker is added to the selected histogram window.

To insert an existing marker:

1 Click the Insert Existing Marker button  to open the Insert Existing Markers window.

2 Select a marker in the list and click Insert Marker. 

The marker lines are added at the defined positions. The label identifies the marker. 
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You can remove markers that you do not need any more:

1 Click one of the vertical lines in the histogram to select the marker.

The lines of the selected marker are displayed bold.

T IP
You can also click the corresponding row in the result table to select the marker.

2 Click the Delete Marker button  to remove the marker.
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How to Configure Markers

You can change the color, name, and the upper and lower limits of the marker:

1 Double-click the desired marker.

– OR –

Right-click the corresponding row in the result table and select Configure Marker from 
the context menu.

– OR –

Select the marker and click the Configure Marker button  in the toolbar.

The Configure Marker dialog box appears.

2 Enter a name for the marker, for example, the used dye (it is advisable to use names that 
identify the marker).

3 Enter a Lower Value (left vertical line).
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4 Enter an Upper Value (right vertical line).

NOTE
The lower and upper values must be within the range of 0.01 – 10000 relative 
fluorescence units.

5 Click the Color button  to open the Color dialog box and select a color.

6 Click OK.
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How to Move the Upper and Lower Limits of Markers

You can change the position of both marker lines by dragging them with the mouse:

1 Position the mouse pointer on a marker line.

The mouse pointer changes its shape to a hand.

2 Drag the line to the desired position.

3 Release the mouse button.

4 Repeat these steps for the other marker line, if necessary.

NOTE
You can change the marker limits also by entering fluorescence values in the 
Configure Marker dialog box (see “How to Configure Markers” on page 228).
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How to Copy Markers to All Histograms

Once a marker is defined, you can copy it in the histograms of all samples (generic assays 
only):

1 Select the marker in the histogram or in the result table.

The Insert the selected marker into all histograms button  is now enabled.

2 Click this button.

The Copy Marker dialog box appears. This dialog box asks you whether or not you want 
to use the marker as reference.

3 Click Yes to use this marker as reference. The marker will be inserted in all other 
histograms of the blue or red channel. When the properties of this marker are changed, 
the changes will be applied to all samples.

– OR –

Click No. The marker will be inserted in all other histograms of the blue or red channel. 
When the properties of this marker are changed, the changes are only applied to the 
current sample.

How to Set the Gating Direction (Generic assay only)

You can use one marker to define the gating direction. In other words, you define whether 
red or blue fluorescence is used as a gate to define a subset in the other histogram. This 
also depends on the dyes that you have used for staining.

You can set both gating directions: either from the blue histogram to the red histogram or 
from red to blue.
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To set the gating direction:

1 Select the marker in the red or blue histogram you want to use as a gate for the other 
histogram. 

The corresponding gating button in the toolbar is now enabled.

2 Click  or  to set the gating direction.

– OR –

Right-click the marker in the histogram or in the result table, and select Gate in 
Red/Blue histogram from the context menu.

The gating direction is displayed in the Information Bar.

If the gating direction is already set, you first have to remove the existing gating.

To remove gating:

Click the Remove Gate button .

The gating is removed and the corresponding gating button is enabled.

NOTE
To change the gating direction in non-generic assays, you first have to change the 
assay to generic. To achieve this, use the Import Setpoints button on the Assay 
Properties tab (refer to “Importing Data” on page 277).
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How to Overlay Histograms

You can compare samples by overlaying their gated histograms. This is useful, for 
example, if you want to see the progress of a reaction or if one sample is used as 
reference.

Overlaying histograms might also be helpful for adjusting the marker position. You can 
overlay all measured samples. Both red and blue histograms are overlaid.

NOTE
You can configure the colors of the overlaid histograms and adjust the scale 
graduation as described in “How to Set Signal Colors for Overlaid Histograms” on 
page 235. 

To overlay histograms:

1 Select the main sample and display the Histogram tab.

2 Click the Overlaid Samples  button to open a drop-down list.

3 Click the sample that you want to use as overlay. 

The histogram curve of the selected sample appears in the histogram view, the 
corresponding entry in the drop-down list is marked with a check, and a color legend 
appears above the graph.

4 Repeat steps 2 and 3 to overlay further histograms.
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To overlay all samples:

1 Click the Overlaid Samples  button to open a drop-down list.

2 Select All Samples to overlay the histogram curves of all samples.

To remove histograms from the overlay:

1 Select the sample that contains the overlaid histograms.

2 Click the Overlaid Sample button  to open the drop-down list.

3 Click the sample that you want to be removed.

– OR –

Click No Overlay to remove all overlaid curves from the histogram.
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How to Set Signal Colors for Overlaid Histograms

You can use the Graph Settings tab in the Options dialog box to configure the signal 
colors (colors of curves in histograms):

1 Select Tools > Options.

2 Click the Graph Settings tab to bring it to the front. 

To configure the signal color:

1 Click the colored square corresponding to the signal. 

The Color dialog box appears. 

2 Select a color for the signal and assign it by clicking OK.
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Displaying the Results of Histogram Evaluations

The calculated results are displayed in result tables, one table below each histogram. 
Markers, gates, several statistical values, and the %-values of events are shown in the 
result tables. 

Each marker you insert in the histogram gets its own row. Note that you can only use one 
marker for gating. The additional markers can be used to evaluate different parts of the 
histogram statistically.

If the option Hide superset curve is disabled in the setpoint explorer, two additional rows 
are displayed in the gated histogram’s result table. The superset curve shows a 
histogram of all measured events; the gate is not considered.

You can export the table data for further evaluation in other applications. See “Exporting 
Data” on page 283.

NOTE
The layout of the result table can be configured (see “Configuring Tables” on 
page 299). Not all of the values listed below may therefore be visible.
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The content of the result tables depends on the gating direction. The histogram that is 
used for gating can display the following results:

Marker All events – this row shows the data for all measured events, for 
example, for all living and dead cells.

The following rows show the data for the subset of cells defined by 
the inserted marker. If you use a predefined assay, the entry can be 
“Calcein on all events”, for example.

Min Minimum fluorescence value of the corresponding marker.

Max Maximum fluorescence value of the corresponding marker.

Events Number of events covered by the marker. For the histogram you use 
for gating, the number of all detected events is displayed in the row 
“All Events”.

% total % of selected events in relation to the total number of events. The 
row “All Events” shows 100%.

% of gated % of events covered by the marker in the gated histogram. Shows no 
value for the gating histogram. 

Mean Mean fluorescence value of the events inside the marker.

StdDev Standard deviation to the mean value.

%CV Coefficient of variation.

GMean Geometric mean.
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The histogram that displays the gated data can show the following data:

Marker All events – this row shows the data for all events that pass the gate.

The following rows show the data for all events covered by the 
inserted marker. If you use a predefined assay, the entry can be 
“Annexin V on subset”, for example.

Min Minimum fluorescence value of the corresponding marker.

Max Maximum fluorescence value of the corresponding marker.

Events Number of events covered by the marker. For the histogram you use 
for gating, the number of all detected events is displayed in the row 
“All events”.

% total % of selected events in relation to the total number of events. The 
marker used for gating is 100%, the table of the gated histogram 
shows the value of the subset.

% of gated % of the gated events in relation to the total number of events. These 
are the events that have passed the gate and are covered by the 
marker of the histogram, for example, by annexin V.

Mean Mean fluorescence value of the events inside the marker

StdDev Standard deviation to the mean value.

%CV Coefficient of variation.

GMean Geometric mean.
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Using Dot Plots for Evaluation

On the Dot Plot tab, cells are displayed as dots, where their red fluorescence intensity is 
mapped on the Y axis and their blue fluorescence intensity is mapped on the X axis. 

NOTE
The lower left region of the dot plot area may show no events, because of the 
threshold for event detection. Dots are only displayed if their fluorescence intensity 
exceeds a minimum limit. The limits are specified in the assay—separately for red and 
blue fluorescence. 

To evaluate the dot plots, you can add regions. Regions are rectangles that can be 
changed in size and position until they include a specific event subset. As a result you get 
the number of cells included in the region related to the total number of cells.

NOTE
You can add/remove regions and gates only in Generic assays.

Additionally, you can insert a horizontal or a vertical gate for one region. This is useful for 
counting all cells that have fluorescence intensities within the horizontal or vertical 
borders of the region. In predefined assays, the vertical side of a region corresponds to 
the marker of the blue histogram, the horizontal side to the red one (see “Using 
Histograms for Evaluation” on page 218). The gate is always displayed and corresponds 
to the range of the marker that is used for gating. If you move a marker in a histogram, the 
region and gate are automatically updated. If you change a region or gate, the marker is 
also updated. Statistics are displayed in the result table below the dot plot.
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How to Add Regions to Dot Plots (Generic Assay only)

You can draw regions in dot plots of generic assays. If there are regions already defined in 
other samples, you can copy these regions in the dot plot of the current sample.

To draw a new region:

1 Click the Insert Region button  in the toolbar. 

The mouse pointer changes its shape to a crosshair.

2 Draw a rectangle into the dot plot. 

New regions are automatically named “Region x”, where x is an auto-incremented 
number. By default, the border color of new regions is black. To make it easier to 
differentiate between regions, you can change their border color (see “How to Configure 
Regions” on page 242).
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To insert an existing region:

1 Select the sample where you want to insert an existing region from another sample and 
click Insert existing region .

The Insert Region dialog box appears.

2 Select the region that you want to insert and click Insert Region.

The region is inserted at its predefined position.

To remove a region:

1 Click the region border to select the region that you want to remove. 

The selected region is highlighted. and the Delete Regions button  is enabled.

2 Click this button.

The region disappears from the dot plot.
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How to Configure Regions

You can change the color of the region border, edit the region’s name, and define the 
position and size of the region.

To configure a region:

1 Double-click the border of the region that you want to configure.

– OR –

Right-click the corresponding row in the result table and select Configure Region from 
the context menu.

– OR –

Click the region border to select the region, and click the Configure Region button  
in the toolbar.

The Configure Region dialog box appears.

2 Enter a Name for the region. 

It is advisable to use an easy-to-understand name.
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3 Enter fluorescence values for the left, right, bottom, and top side of the rectangle to 
define position and size of the region. 

These values correspond to the upper and lower marker limits of the blue and red 
histograms.

4 Click the ... button next to the color square to open the Color dialog box, and select a 
color for the region border.

5 Click OK.

To color dots inside regions:

Click the Color Dots button  in the toolbar.

All dots inside the regions now have the same color as the region border. In case of 
overlapping regions, dots are colored with the color of the last added, re-positioned or 
resized region.
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How to Change Position and Size of a Region

You can change the size and position of regions to restrict the number of included events. 
You can work graphically with the mouse or enter the values in the Configure Region 
dialog box.

To move a region:

1 While pressing the Shift key, click the region border, and drag the region to the new 
position.

2 Release the mouse button.

To change size and position with the mouse:

1 Click the region border to select the region.

2 Position the mouse pointer on any corner of the selected region. 

The mouse pointer changes its shape to a double arrow.

3 Click and drag the border to the new size.

Upon moving, the mouse pointer changes its shape to a crosshair and the borders of 
the region appear as dashed lines.

4 Release the mouse button.
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To change size and position numerically:

1 Double-click the region to open the Configure Region dialog box.

2 Enter fluorescence values for the left, right, bottom, and top side of the rectangle to 
define position and size of the region. 

These values correspond to the upper and lower marker limits of the blue and red 
histograms.

3 Click OK.

How to Insert a Region in All Dot Plots

If you have defined a region for one sample, you can copy it to the other samples of the 
assay.

To insert a region in all dot plots:

1 Left-click the region border to select the region that you want to use as source. 

The Insert region into all dot plots button  is enabled.

2 Click this button

The Copy Region dialog box appears, which asks whether or not the source region 
should be used as reference. The region will be inserted in the dot plots of all other 
samples. When you change the properties of the region, all copies of the region will also 
be changed.

3 Click Yes to define the source region as reference.

– OR –
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Click No to create new regions that are not “connected”. The region will be inserted in 
the dot plots of all other samples. When the properties of the region are changed, the 
changes affect only the selected sample.

The region is copied to all samples of the assay.

How to Work with Gates in Dot Plots

You can insert gates only in generic assays. For predefined assays, the gate is already 
defined. 

Before you can insert a gate, you have to draw a region (see “How to Add Regions to Dot 
Plots (Generic Assay only)” on page 240). If a gate is already set, you first have to remove 
the existing gate.

To add a gate to a region:

1 Left-click the region border to select the region to which you want to add the gate. 

The gating buttons in the toolbar are enabled.

2 Click the Horizontal Gate button  or the Vertical Gate button  to set a gate along 
the horizontal or the vertical borders of the selected region.

In the result table, a value appears in the % of gated column.

If the gating direction is already set, you first have to remove the existing gate:

1 Left-click the region border to select the region. 

If a gate already exists, the Remove Gate button  is enabled.

2 Click this button. 

The gate is removed and the gating buttons are enabled.
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Displaying the Results of Regions

The measurement results and calculations for regions are displayed in the result table 
below the dot plot. In predefined assays, only one region is available, while for generic 
assays, dot plots can have as many regions as you like.

The following values are displayed:

Region The default region All Events is always displayed in the first row and 
shows the values for all detected events. For each further region (see 
“How to Add Regions to Dot Plots (Generic Assay only)” on 
page 240), a row is added to the table.

XMean Mean fluorescence values in x direction.

YMean Mean fluorescence values in y direction.

#Events Number of events for each region added to the dot plot.

% Total Percentage of events for each region added to the dot plot. 

% of gated Percentage of the gated events in the region.

StdDevX Standard deviation to the mean fluorescence value in x direction.

StdDevY Standard deviation to the mean fluorescence value in y direction.

CV%X Coefficient of variation of the x values.

CV%Y Coefficient of variation of the y values.

X GMean Geometric mean of the x values.

Y GMean Geometric mean of the y values.
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Evaluating Antibody Staining, Apoptosis, and GFP Assays

With the 2100 expert software, several predefined assays are supplied. You should only 
use each assay for the specific experiment for which it was developed. For example, you 
have to use the read dye for detection of apoptosis (calcein and Cy5, for example):

• “Evaluating Antibody Staining Assays” on page 249.

• “Evaluating Apoptosis Assays” on page 253.

• “Evaluating GFP Assays” on page 259.
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Evaluating Antibody Staining Assays

Antibody staining lets you measure protein expression on the surface or inside a cell by 
means of specific antibodies. Either the primary antibody itself is conjugated with a dye 
or you must use a labeled secondary antibody that recognizes the primary antibody. 
When you measure the fluorescence of the cells, you can compare the relative 
expression of protein in individual cells and use this information for population analysis. 
Typically, you can use a red dye such as APC (Allophycocyanin) or Cy5 to measure 
antibody presence. 

You can use a blue dye like calcein to detect whether or not the cells are living, or like 
SYTO 16 to stain the nucleic acids of all cells. For detailed information, refer to the 
application note Detecting Cell Surface and Intracellular Proteins with the Agilent 2100 
Bioanalyzer by Antibody Staining.

For a detailed description on how to evaluate the results using markers and regions, refer 
to “Using Histograms for Evaluation” on page 218, and to “Using Dot Plots for 
Evaluation” on page 239.

Gating direction

The gating direction is from blue fluorescence to red fluorescence. Depending on the dye 
you use, you should use all cells (nucleic acid dye) or only living cells (calcein living dyes) 
for gating.
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Histogram Evaluation

The blue histogram is used for gating. High fluorescence in the blue histogram means 
that the cells are living (if a life-indicating dye is used). Low fluorescence means the cells 
are dead. If you use a nucleic acid dye, you cannot distinguish between living and dead 
cells, you can only count all measured cells. See the following image as an example:

The values are displayed in the result table below the blue histogram:

Low fluorescence 
value indicates dead 
or non-healthy cells

High fluorescence 
value indicates living 
cells

All measured events

All events in relation to 
the blue marker (here 
calcein)

Living cells related to all measured cells (high calcein fluorescence)
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When using the calcein marker in the blue histogram for gating, only living cells are 
considered for building the histogram of the red dye. High red fluorescence values 
indicate living cells with bound antibodies, low red fluorescence values living cells 
without bound antibodies. See the following example.

The values are displayed in the result table below the red histogram:

Low fluorescence values 
indicate low binding of 
labeled antibodies

High fluorescence 
values indicate binding 
of labeled antibodies

Percentage of all cells with 
high red fluorescence 
selected by the red marker

Percentage of the living cells

Amount of living cells with high red fluorescence in relation to the amount of living cells
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Dot plot evaluation

If you switch to the Dot Plot tab, one region is displayed in the dot plot. The red 
fluorescence values of the region are related to the marker in the red histogram, the blue 
fluorescence values to the marker in the blue histogram. As in the histogram evaluation, 
high blue fluorescence and high red fluorescence mean living cells with bound 
antibodies. See the following example.

Cumulation of high blue and high red fluorescence 
indicates strong binding of labeled antibodies in living cells
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The results of the dot plot evaluation are numerically displayed in the result table:

Evaluating Apoptosis Assays

The apoptosis assay can be used to examine how many apoptotic cells are within a living 
cell population. Dead (or necrotic) cells can be excluded from the evaluation.

For a detailed description on how to evaluate the results using histograms and regions, 
refer to “Using Histograms for Evaluation” on page 218 and “Using Dot Plots for 
Evaluation” on page 239.

Living or dead cells

In most cases, you want to know whether cells are dead or alive at a specific time. For 
this, you can use calcein-AM as living cell dye, for example. This dye accumulates in 
intact cells, whereas it will leak out of damaged cells. Once inside the cells, the colorless 
AM ester is cleaved by esterases, resulting in the formation of the highly fluorescent 
calcein. The number of events resulting from a calcein-related staining thus gives you the 

All measured events

Events covered by the region

Amount of living cells in relation to all measured cells

Amount of living cells with high antibody binding in relation to all living cells
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number of living cells in a sample. For detailed information, refer to the application note 
Apoptosis Detection by Annexin V and Active Caspase 3 with the Agilent 2100 
Bioanalyzer.

Apoptotic cells

In apoptotic cells, phosphatidylserine is no longer confined to the inner leaflet of the 
plasma membrane bilayer. Phosphatidylserine becomes accessible on the outer surface 
of the cell membrane and can be bound with high affinity by the protein annexin V, which 
can be labeled with biotin or dyes such as Cy5.

Gating direction

The gating direction is from blue fluorescence (living cells) to red fluorescence (annexin).

Histogram evaluation

The two histograms displaying the results of the assay are related to calcein (blue 
fluorescence) and annexin V (red fluorescence). High fluorescence values in the blue 
histogram indicate living cells, low values correspond to dead cells. See the following 
image as an example.
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The values are displayed in the result table, each histogram has its own table:

When using the calcein marker in the blue histogram for gating, only the living cells are 
considered for building the red histogram. High red fluorescence values indicate living, 
apoptotic cells, low red fluorescence values indicate living, non-apoptotic cells. See the 
following example.

Low fluorescence value 
indicates dead cells

High fluorescence value 
indicates living cells

All measured events

All events in relation to the 
blue marker (here calcein)

Living cells in relation to all measured cells (high calcein fluorescence)
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Low fluorescence value 
indicates living non-apoptotic 
cells

High fluorescence value 
indicates living apoptotic cells 

Percentage of all cells with 
high red fluorescence 
selected by the red marker

Amount of the living cells in relation to all measured events

Amount of living cells with high red fluorescence in relation to the amount of living cells
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Dot plot evaluation

If you switch to the Dot Plot tab, one region is displayed in the dot plot. The red 
fluorescence values of the region are related to the marker in the red histogram, the blue 
fluorescence values to the marker in the blue histogram. As in the histogram evaluation, 
high blue fluorescence and high red fluorescence represent living cells with annexin V 
binding. See the following example.

Cumulation of high blue and high red 
fluorescence indicate living apoptotic cells
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The results of the dot plot evaluation are displayed in the result table.

All measured events 

Events covered by the 
region

Amount of living cells with high red fluorescence in relation to the amount of 
living cells

Amount of living cells with high red fluorescence in relation to the 
amount of all cells
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Evaluating GFP Assays

With GFP (Green Fluorescent Protein) assays, the fluorescent substance is not a dye, but 
a protein. Cells can be transfected with a target gene together with the GFP-producing 
gene. Transfected cells produce the fluorescent protein, which can be detected. The 
fluorescence shows you the success of the transfection experiment. For detailed 
information on GFP assays, refer to the application note Monitoring transfection 
efficiency by green fluorescent protein (GFP) detection with the Agilent 2100 Bioanalyzer.

For a detailed description on how to evaluate the results using histograms and regions, 
refer to “Using Histograms for Evaluation” on page 218 and “Using Dot Plots for 
Evaluation” on page 239.

Gating direction

The GFP has a green fluorescence (absorption in the blue). Because the reference dye 
(CBNF) fluoresces in the red, the gating direction is from red to blue. CBNF stains living 
cells, so you can detect living, GFP-positive cells.

Histogram evaluation

The two histograms displaying the results of the assay are related to CBNF (red 
fluorescence) and GFP (blue fluorescence). High fluorescence values in the red 
histogram indicate a staining with CBNF, which is associated with living cells. See the 
following image as example.
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The values are displayed in the result table, each histogram has its own table.

After gating by using the red histogram, in the blue histogram only CBNF-stained cells 
are displayed. High blue fluorescence values indicate GFP-producing cells. See the 
following example.

Low fluorescence value 
indicates dead cells

High fluorescence value is 
associated with living cells

All measured events

All events related to the red marker (here CBNF)
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High fluorescence 
value indicates 
GFP-producing cells

Percentage of GFP containing 
cells in relation to all 
measured  cells

Amount of the CBNF containing cells in 
relation to all measured cells

Percentage of GFP containg cells in relation to the cells 
gated by the CBNF marker
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Dot plot evaluation

If you switch to the Dot Plot tab, one region is displayed in the dot plot. The red 
fluorescence values of the region are related to the marker in the red histogram, the blue 
fluorescence values to the marker in the blue histogram. Corresponding to the histogram 
evaluation, high blue fluorescence and high red fluorescence indicate living 
GFP-producing cells. See the following example.

Cumulation of high blue and high red fluorescence 
indicates living GFP expressing cells
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The results of the dot plot evaluation are displayed in the result table.

All measured events 

Events covered by the region

Amount of cells with high CBNF fluorescence and high GFP 
fluorescence in relation to all measured events

Amount of cells with high GFP fluorescence in relation to the amount of 
CBNF-stained cells.
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Working with Chip Data and Assays

You can make efficient use of the chip and assay data generated by the 2100 expert 
software, if you know the following fundamentals and operating techniques:

• “2100 Expert Data Overview” on page 265

• “Handling Assays” on page 268

• “Handling Chip Data” on page 273

• “Organizing, Backing up, and Archiving 2100 Expert Data” on page 275

• “Importing Data” on page 277

• “Exporting Data” on page 283

• “Printing Reports” on page 292

• “Configuring Tables” on page 299
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2100 Expert Data Overview

The 2100 expert software manages data in the following different formats:

• Assay files (.xsy)

• Chip data files (.xad)

• Comparison files (.xac)

• Verification result files (.xvd)

• Diagnostics result files (. xdy)

• Result flagging rule files (.xml)

Assay files

Assay files (.xsy) contain the following information:

• Data acquisition and analysis setpoints

Acquisition setpoints are instrument commands and acquisition parameters. Analysis 
setpoints are evaluation parameters, some of which you can modify.

• Assay information

All parameters defined by the assay, such as assay type, title, and version.

• Chip and sample information

These are chip comments, sample names and comments.

• Marker and region definitions (flow cytometric assays only)

Included are associated parameters, such as the gating direction.
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• Ladder table and peak table (electrophoretic assays only)

• Result flagging rules (electrophoretic assays only)

Chip data files

Chip data files (.xad) contain the following information:

• Measurement results

After each chip run, the measurement results—also called “raw data”—are 
automatically saved in a new chip data file. Electrophoretic measurement results are 
pairs of migration time and fluorescence intensity values, flow cytometric 
measurements are triplets of migration time, red fluorescence, and blue fluorescence.

• Base assay information

Because a chip run is always based on an assay file, all information from the assay file 
becomes part of the chip data file.

• Run log

Events occurring during the chip run, such as the start and end time, or any errors or 
problems are entered in a “run log”, which is also saved in the chip data file.

• Evaluation information

These are modifications you made during data evaluation, such as modified gel 
coloring, manually set markers, manual integration, modified setpoints, modified result 
flagging rules, or definitions of new markers and regions.
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Comparison files

You can compare the measurement results from different chip runs (electrophoretic chip 
data files of same assay class only) by collecting samples from different chip data files 
(.xad) and storing them in a comparison files (.xac). It is then possible to overlay 
electropherograms of these samples, for example, but also to compare gel-like images or 
data tables.

Verification result files

Verification result files (.xvd) contain results of qualification tests regarding the 
bioanalyzer hardware and software. The files are stored in the “..\validation” subfolder of 
the 2100 expert installation directory. For each verification run, an .xvd file is generated. 

Date and time of the verification run are included in the file name. Example: 
“Verification_23-05-2005_10-28-40.xvd”. 

Diagnostics result files

To ensure proper functioning of the bioanalyzer hardware you should run hardware 
diagnostics tests on a regular basis. The results of these hardware tests are stored in 
diagnostics results files (.xdy) in the “..\diagnosis” subfolder of the 2100 expert 
installation directory.

Result flagging rule files

You can export and import result flagging rules from other assay or chip data files. Result 
flagging rules are stored in .xml files.
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Handling Assays

Predefined Assays

Predefined assays are provided with 2100 expert. They are meant and prepared for 
measurements using the available LabChip kits. 

Predefined assays such as Apoptosis or DNA 1000 are write-protected. Although you can 
open predefined .xsy files and edit some of their properties, you cannot save any changes 
under the original file name.

Custom Assays

You can derive your own assays from the predefined assays as described in “How to 
Create a Custom Assay” on page 270. 

The main benefit of custom assays is that you have to do the following only once in the 
assay file, instead of doing it again and again in the chip data files:

• Modify assay setpoints (data analysis setpoints).

• Enter information on chip, samples, and study.

For example, if your sample names are to be the same for a series of chip runs.

• Define rules for result flagging (electrophoretic assays only).

• Define markers and regions for evaluation (flow cytometric assay Generic only).

For example, if you want to adjust marker positions and use these for future chip runs.

You can modify custom assays at any time. See “How to Modify a Custom Assay” on 
page 271.
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TIP
If you just want to view the properties of a custom assay, you can open the assay file 
in read-only mode, ensuring you do not make accidental changes.

The Assays menu is dynamically built from the structure and contents of the “..\assays” 
subdirectory of the 2100 expert installation folder.

T IP
You can add items to the Assays menu by placing assay (.xsy) files—your own assays, 
for example—in subdirectories of the “..\assays” directory.
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How to Create a Custom Assay

To create a custom assay:

1 Switch to the Assay context.

2 From the Assays menu, select an assay.

– OR –

Select File > Open and open an assay (.xsy) file.

The file appears in the Tree View Panel.

NOTE
If you want to create a new flow cytometric assay with free gating direction or with 
more than one marker or region, open and modify the assay “Generic.xsy”.

3 Switch to the Assay Properties Tab to modify the assay setpoints if required.

4 Switch to the Chip Summary Tab to enter chip, sample, and study information.

5 For flow cytometric assays, define markers and regions on the Histogram Tab 
(Single/Grid View) and Dot Plot Tab (Single/Grid View).

6 For electrophoretic assays, define flagging rules on the Result Flagging Tab.

7 Select File > Save As to open the Save As dialog box.

8 Under Save as type, select (.xsy), and enter a name and location for the new assay.

9 Click Save to create the new assay.
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How to Modify a Custom Assay

NOTE
You cannot save modifications to predefined assays such as Apoptosis or DNA 1000.

To modify a custom assay:

1 From the File menu select Open.

The Open dialog box appears.

2 Select an assay (.xsy) file and click Open.

The assay appears in the Tree View Panel and the Assay Properties Tab is displayed.

3 Modify the assay by making changes on the following tabs:

– Modify assay setpoints on the Assay Properties Tab.

– Modify or enter additional chip, sample, and study information on the Chip Summary 
Tab.

NOTE
The study description is stored in the 2100 expert system file. Altering the study 
description of an assay will not affect the entries in the data files that were previously 
generated from this assay. To update this information in the data files, too, they must 
be opened, and the study must be assigned again.

– For flow cytometric assays, define or modify markers and regions on the Histogram 
Tab (Single/Grid View) and Dot Plot Tab (Single/Grid View).
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– For electrophoretic assays, define or modify flagging rules on the Result Flagging 
Tab.

4 From the File menu select Save to save the method with the current name or Save as to 
save it with a new name.
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Handling Chip Data

Chip data (.xad) files are automatically generated at the end of a chip run. The .xad files 
are given names that correspond to the choices you have made in the Options dialog box 
(see “How to Specify Data File Names and Directories” on page 306).

Modifying and saving chip data files

2100 expert allows to re-open chip data files, reanalyze them using different evaluation 
parameters and store the new results. You can save modifications either to the original 
file (File > Save) or under a new file (File > Save As).

NOTE
Raw data acquired from the bioanalyzer is not changed—only evaluation and display 
of the results can be changed and saved.

If you alter the data shown in any way after it has been saved and try to exit the program 
or switch to a different context (to acquire new data, for example), a dialog box will 
appear asking whether or not you wish to save the changes.

Opening chip data files as read-only

A chip data file can be opened as read-only; the Title Bar will show “(Read-Only)” at the 
end of the filename. The read-only file can be edited but may not be saved under the 
same name. If you attempt to save an edited read-only file, and error message will be 
displayed explaining that the file is a read-only file. 
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The benefit of opening chip data files as read-only is to prohibit you or other users from 
making changes that would alter the file in any way. Because the 2100 expert software 
allows you to open chip data files, modify data, and save them, you may prefer to ensure 
that the original parameters that were used to create the file are not altered.
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Organizing, Backing up, and Archiving 2100 Expert Data

As you begin to work with the 2100 expert software, it is good practice to organize your 
files. If you are not the only user of the bioanalyzer, creating a directory within which to 
save your files is recommended; having each person save files to their own directory will 
speed the process of finding a particular file when someone wishes to examine the data 
again. Even if only one person uses the 2100 expert software, it is still wise to review 
your files periodically, archive files you are no longer using but wish to save, and discard 
unneeded files.

Organizing 2100 Expert Data

Each user in your laboratory may want to specify a particular prefix that will easily 
differentiate their data files from any others.

To do this, switch to the System context, go to the System Wide Settings tab, and select 
Data Files in the tree navigation. Then activate the Prefix check box, and edit the prefix 
string as you require. Note that you can also modify the file prefix before you start a chip 
run. Additionally, you may specify that a new directory is created each day for storage of 
that day’s runs. To do this, activate the Create Daily Subdirectories check box on the 
same screen.

Backing up 2100 Expert Data

It is strongly recommended to save your files to a backup disk or on CD/DVD on a regular 
basis. This allows to retrieve the data in case of a system crash or other cases of data 
loss. 
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Archiving 2100 Expert Data

The difference between archiving and backing up is that in the archiving process the data 
will be removed from its original place and moved while during the backup process only a 
copy is taken (depending on the tools you use).

It is a good idea to periodically archive your files to a CD/DVD to remove them from your 
hard disk. Depending on the amount of hard disk space available to the 2100 expert 
software, you may need to clear space on your hard drive to ensure that you will have 
enough room to save upcoming chip run data. 
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Importing Data

When working with assay (.xsy) or chip data (.xad) files, you enter specific information 
that you may want to reuse. To support the reuse of data, 2100 expert has the following 
import capabilities:

• “Importing Bioanalyzer Files” on page 278

• “Importing Data Analysis Setpoints” on page 279

• “Importing Chip, Sample, and Study Information” on page 281

You can import result flagging rules definitions for result flagging into electrophoretic 
assay or chip data files:

• “Importing Result Flagging Rules” on page 282
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Importing Bioanalyzer Files

You can import data, assay and method files that were generated with other Agilent 2100 
bioanalyzer systems. You can even import data and assay files from the older Bio Sizing 
and Cell Fluorescence software applications.

To import assay files:

1 Switch to the Assay context.

2 From the File menu, select Import to display the Open dialog box.

3 Select a file of any of the following types:

– .xsy (2100 expert assay file)

– .asy (Bio Sizing assay file)

– .csy (Cell Fluorescence assay file)

4 Click Open.

The imported file appears in the Tree View Panel, and the Assay Properties tab shows 
information about the assay.

Upon importing, the file gets converted to a new 2100 expert assay file (.xsy). 

To import chip data files:

1 Switch to the Data context.

2 From the File menu select Import to display the Open dialog box.

3 Select a file of any of the following types:

– .xad (2100 expert assay file)
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– .cld (Bio Sizing assay file)

– .cad (Cell Fluorescence assay file)

4 Click Open.

The imported file appears in the Tree View Panel, and the electropherogram grid view 
shows an overview of all samples.

Upon importing, the file gets converted to a new 2100 expert chip data file (.xad).

Importing Data Analysis Setpoints

You can import data analysis setpoints from other assay (.xsy) or chip data (.xad) files of 
the same type.

Note the following when importing:

• Electrophoresis files to be imported must be of the same assay type. This means that 
you cannot import setpoints from a DNA 1000 assay into a DNA 500 assay, for example.

• Flow cytometry files to be imported can be of any flow cytometric assay type, but the 
import will change the type of the current file to Generic.

To import data analysis setpoints:

1 On the Assay Properties tab, click Import Setpoints.

2 The Open dialog box appears.

3 Select the file from which you want to import, and click Open.
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NOTE
For flow cytometry files, the import will delete all existing markers and regions in the 
current file, and change the current assay to a Generic assay. A message box appears 
that prompts you to confirm this change.

4 Click Yes.

NOTE
Importing data analysis setpoints overwrites all current setpoint values.

– All files: the setpoint values are updated in the setpoint explorer, and immediately 
applied to the measurement results (if any).

– Flow cytometry files: the new markers and regions are now available for evaluation, 
and calculations based on the new markers and regions are immediately done.

5 From the File menu, select Save to make the changes permanent.
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Importing Chip, Sample, and Study Information

On the Sample Information and Study Information sub-tabs of the Chip Summary tab, you 
can enter names and comments regarding chip, samples, and study. The information you 
enter here may be very similar for further chip runs or other assays. Once you have 
entered the information, you can export it into a separate file (see “Exporting Chip Run 
Data” on page 284), which you can then import into other chip data (.xad) or assay (.xsy) 
files instead of typing it anew.

The import/export files can have the extension .txt or .csv, and have a fixed form, which 
differs for electrophoretic and flow cytometric assays. 

To import chip, sample, and study information:

1 On the Chip Summary tab, click Import.

2 The Import Sample Information dialog box appears.

3 Select the file that contains the information you want to import, and click Open.

The Sample Information and Study Information sub-tabs update to show the imported 
data.

4 From the File menu, select Save to make the changes permanent.
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Importing Result Flagging Rules

You can import result flagging rules into electrophoretic assay (.xsy) or chip data (.xad) 
files. Result flagging rules can be stored in .xml files (see “Exporting Result Flagging 
Rules” on page 291).

To import result flagging rules:

1 Open an electrophoretic assay or chip data file in the respective context.

2 Switch to the Result Flagging Tab.

3 In the Result Flagging toolbar click .

The Load Rules dialog box appears.

4 Select the .xml file that contains the set of result flagging rules, and click Open.

The imported rules appear in the rule list.
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Exporting Data

2100 expert allows you to export the results of your chip runs in a variety of formats. The 
exported data can be used for further evaluation with other applications, such as text 
processors, graphic tools, MS Excel®, or flow cytometry applications. 

You can export the chip run data of the currently loaded file either manually or 
automatically:

• “Exporting Chip Run Data” on page 284

• “Exporting Chip Run Data Automatically” on page 286

If you want to export only parts of your measurement results:

• “Exporting Tables” on page 287

• “Exporting Graphs” on page 288

• “Copying Graphs and Tables into the Clipboard” on page 289

Information that you have entered to document a chip run can be exported for reuse in 
future chip runs:

• “Exporting Chip, Sample, and Study Information” on page 290

From electrophoretic assay or chip data files, you can also export rule definitions for result 
flagging:

• “Exporting Result Flagging Rules” on page 291
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Exporting Chip Run Data

To export chip run data:

1 Switch to the Data context.

2 In the Tree View Panel, select a chip data (.xad) .file or load a file.

3 From the File menu, select Export.

If you selected an electrophoretic chip data file, the Electrophoresis Export Options 
dialog box appears.

If you selected a flow cytometric chip data file, the Flow Cytometry Export Options 
dialog box appears.

4 Select the export categories, and specify a target directory.
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NOTE
Keep in mind that exporting a chip data file can require up to 20 MB of disk space. In 
particular, exporting electropherograms and gel-like images as .tif or .bmp files may 
take up a lot of disk space.

5 Click Export.

Several system dialog boxes appear, one for each export category, allowing you to 
check and modify names and locations of the export files. Clicking the Save button in 
these dialog boxes finally starts the export.

T IP
Chip run data can be automatically exported every time a chip run has finished. Refer 
to “Exporting Chip Run Data Automatically” on page 286 for details.
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Exporting Chip Run Data Automatically

NOTE
Keep in mind that exporting a chip data file can require up to 20 MB of disk space. In 
particular, exporting electropherograms and gel-like images as .tif or .bmp files may 
take up a lot of disk space.

To enable and configure automatic export:

1 Switch to the System context and select Auto Export in the tree navigation.

2 Activate the Auto Export check box.

3 Specify the export categories that are to be included in the exported files for 
electrophoretic and flow cytometric chip runs.

4 Switch to Default Export Directories in the tree navigation and specify the target 
directories.

From now on, chip run data is automatically exported every time a chip run has finished.

NOTE
If you stop a chip run, auto export does not take place.
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Exporting Tables

You can export:

• Result tables, peak tables, fragment tables, and ladder tables as .csv files or .xls files.

• Log book tables as .html or .txt files.

To export a result table, peak table, fragment table, or ladder table:

1 On the Assay Properties, Electropherogram, Gel, Histogram, or Dot Plot tab, right-click 
the heading row of a table.

2 From the context menu, select Export. 

The Save As dialog box appears.

3 Enter a file name and choose the destination directory.

4 Select .csv or .xls as export file format.

5 Click Save.

T IP
Result tables can be automatically exported every time a chip run has finished. Refer 
to “Exporting Chip Run Data Automatically” on page 286 for details.

To export a log book table:

1 On the Log Book tab, right-click a table.

2 From the context menu, select Export.

The Export Data dialog box appears.
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3 Click the ... button to specify the file name, the destination directory, and the file type. 
You can choose between HTML file for .html output and Tabbed text file for .txt output.

4 Specify whether you want to export the Selected rows only or All visible rows.

5 Click OK.

Exporting Graphs

You can export graphs as individual graphic files. This applies to all graphs that can be 
displayed in 2100 expert such as electropherograms or dot plots.

To export a graph:

1 Right-click the graph, and select the appropriate entry (e.g. Save Gel or Save 
Electropherogram) from the context menu.

– OR –

Click the  button in the toolbar.

The Save As dialog box appears.

2 Under File name, enter a name and choose the destination directory.

3 Under Save as type, select a graphic file format: .bmp, .jpg, .wmf, .tif or .gif.

4 Click Save.

The graph is written to the specified file.
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Note the following:

• Histograms: only one histogram graph is exported, either the red or the blue histogram.

• Electropherograms: if the grid view is active, an overview image of the 
electropherograms (of all samples and the ladder) is exported.

T IP
Electropherograms, gel-like images, histograms, and dot plots can be automatically 
exported every time a chip run has finished. Refer to “Exporting Chip Run Data 
Automatically” on page 286 for details.

Copying Graphs and Tables into the Clipboard

You can copy graphs into the clipboard. This applies to all graphs that can be displayed in 
2100 expert, such as electropherograms or dot plots.

You can also copy tables (or parts of tables) into the clipboard. This applies to most of the 
tables that can be displayed in 2100 expert, such as result tables or log book tables.

To copy a graph or table into the clipboard:

1 Right-click the graph or table (region).

2 From the context menu, select Copy Gel/Copy Electropherogram (graphs) or Copy To 
Clipboard (tables).

– OR –

Click the  button in the toolbar.
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You can now switch to a word processing, spreadsheet, graphics, or other application, 
and paste the graph or table there.

Exporting Chip, Sample, and Study Information

On the Sample Information and Study Information sub-tabs of the Chip Summary tab, you 
can enter names and comments regarding chip, samples, and study. The information you 
enter here may be very similar for further chip runs or other assays. Once you have 
entered the information, you can export it into a separate file, which you can then import 
into other chip data (.xad) or assay (.xsy) files instead of typing it anew.

The import/export files can have the extension .txt or .csv, and have a fixed form, which 
differs for electrophoretic and flow cytometric assays. 

To export chip, sample, and study information to a file:

1 On the Chip Summary tab, click Export.

The Export Sample Information dialog box appears.

2 Specify a file name and location for the file to which you want to export.

3 Click Save.
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Exporting Result Flagging Rules

You can export result flagging rules for reuse in other electrophoretic assay (.xsy) or chip 
data (.xad) files (see “Importing Result Flagging Rules” on page 282). Result flagging 
rules are stored in .xml files.

To export result flagging rules:

1 Open the electrophoretic assay or chip data file with the desired result flagging rules in 
the respective context.

2 Switch to the Result Flagging Tab.

3 In the Result Flagging toolbar click .

The Save Rule Definitions dialog box appears.

4 Browse for a folder where you want to store the rules, and specify a name for the .xml 
file.

5 Click Save.
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Printing Reports

For documentation and presentation purposes, you can print reports for assay (.xsy), chip 
data (.xad), verification results (.xvd), and comparison (.xac) files.

You can print all reports manually, see “How to Print a Chip Run Report” on page 293. 
When printing manually, a preview function allows you to view the printout before 
starting the print job.

The 2100 expert program can also be set to print customized chip run reports 
automatically at the end of the run. These reports can be set up to contain different 
information (settings for the manual and automatic print functions are maintained 
separately). See “How to Turn on and Configure Automatic Printing of Chip Run Reports” 
on page 297 for more information. 

T IP
Beside sending reports to a printer, you can also create .pdf and .html files.
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How to Print a Chip Run Report

The following information can be included in a chip run report:

• You can always include:

– Run summary—general data about the assay, and sample information.

– Assay details—complete list of data analysis setpoints.

– Run Logbook

– Signature Logbook

– Audit Trail

• For flow cytometric chip data files (.xad) you can include:

– Dot plot summary—all regions shown in an overview.

– Dot plot statistics—all statistical data of the result table.

– Histogram summary—all histograms shown in an overview.

– Histogram statistics—all statistical data of the blue and red histograms’ result 
tables.

• For electrophoretic chip data files (.xad), depending on the assay type you can include: 

– Electropherograms

– Gel-like image

– Result tables

– Standard curve

– Calibration curve
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To print a report:

1 Switch to the Data context.

2 In the Tree View Panel select the chip data (.xad) file you want to generate a report of.

3 From the File menu select Print.

Depending on the file type different dialog boxes appear.

4 You generally have the following possibilities:

– select the items to be included in the report from the Print Item section

– select the wells to be included from the Wells section

– select the appropriate options

– specify whether you want to generate the report as a file (PDF or HTML)



Contents ▲ 295 ▼ Index

NOTE
Your selections here are separate from the Auto Print selections (they do not affect 
each other). Both are used by default the next time you print (even after restarting the 
program).

5 Use the Page Setup and Printer buttons to access system dialog boxes, allowing you to 
select a printer, and specify the print medium and page layout.

6 Click the Preview button to get a preview of the printouts or files to be generated. 

7 Click Print to print out the pages or generate the file(s).
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The following example shows the “Run Summary” part of an RNA chip run report. 
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How to Turn on and Configure Automatic Printing of Chip Run Reports

A report can be automatically printed on a printer or generated as a file at the end of each 
chip run. Saving reports as files can be helpful for documentation purposes.

To enable and configure automatic printing:

1 Switch to the System context.

2 Select Run and Result in the tree navigation.

3 Activate the Auto Print check box and click the Settings button next to this check box.

The Auto Print dialog box appears.

NOTE
The Auto Print settings are independent from those made via the Print command of 
the File menu .

4 Adjust the settings:
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– In the Print Item section, select the options that are to be included in the report.

– In the Save To File section, you can redirect the automatic printouts to .pdf and .html 
files.

Note that no print output is generated if you select the PDF and/or HTML option.

– Using the Page Setup and Printer buttons, you can access system dialog boxes, 
allowing you to select a printer for the automatic print, and specify the print medium 
and page layout.

5 Click OK to confirm the automatic print settings.
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Configuring Tables

2100 expert uses various tables to present data:

• Result tables

• Peak tables

• Fragment tables

• Log book tables

In some cases, you might want to reorganize the way the data is presented. To do so, you 
can hide or show columns, change the column sequence, and adapt the table height.

The following example demonstrates how to add the migration time to the Peak Table.
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Showing and Hiding Columns

To add the Aligned Migration Time column to the table:

1 Right-click the heading row of a table and select Configure Columns from the context 
menu.

The Configure Columns dialog box opens.
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2 Move any desired column headers from the Available list to the Displayed list.

3 Configure the order of the column headers in the Displayed list by using the Up and 
Down buttons. 

4 Click OK.

A new column Aligned Migration Time is inserted in the table:
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Changing the Column Sequence

TIP
You can set the column sequence also using the Up and Down buttons in the 
Configure Columns dialog box.

To change the column sequence of a table:

1 Position the mouse pointer on a column header.

2 Click and hold the left mouse button, and drag the header cell to the desired position.

While dragging, a green arrow indicates the target position.

3 Release the mouse button.

The column has moved to its new position:
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Changing the Table Height

You can customize the view by changing the height of the table.

To increase or reduce the table height:

1 Position the mouse pointer above the heading row of the table and move it upwards 
until the cursor’s shape changes to a double arrow.

2 Click and hold the left mouse button and drag up or down.

3 Release the mouse button.
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In this example, the Peak Table freed screen space for the gel-like image above the table:
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Administering System Functions

The 2100 expert software provides the following configuration options and system 
functions:

• Default data file names and directories can be specified. Also, settings such as for 
automatic printing or automatic data export can be set up. See “Configuring 
2100 expert” on page 306 for details.

• Log books are provided that record all important actions and messages in the 
2100 expert software. See “Using Log Books” on page 316 for details.
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Configuring 2100 expert

The available options for configuring the 2100 expert software can be found in the 
System context on the System Wide Settings tab.

How to Specify Data File Names and Directories

The measurement results are stored automatically when the chip run is complete. To 
make it easier for you to identify the chip data files, you can configure an automatic 
naming scheme for the files.
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To specify the names and destination for generated chip data files:

1 Switch to the System context and select the System Wide Settings tab.

2 Select Data Files in the tree navigation.

The Data Files screen becomes visible:

3 In the Data File Name section, select the check boxes of the strings you want to insert 
in the file names:

Option Meaning

Prefix Inserts an arbitrary string to identify the data file. This string can be 
modified. The default file prefix is “2100 expert”.

Assay Class Inserts the assay class in the file name. Examples: “DNA1000”, 
“GFP”, “Apoptosis”.
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4 In the Data File Directory section, specify the Default Directory where the chip data files 
are to be stored. Use the Browse button to select a directory or click Reset if you want 
to use the “..\Data” directory under the 2100 expert installation directory.

5 Optionally, you can select the check box Create Daily Subdirectories if you want daily 
subdirectories to be created.

This option helps you to better organize your chip data files. If selected, a subdirectory 
is created for every day in which a chip run was started. The name of the subdirectory 
has the format “YYYY-MM-DD”, for example, “2005-01-22“. All chip data files generated 
on this day will be stored in this subdirectory. 

6 In the Data File Format section, select whether you want to save the data files in Binary 
Format or in XML Format.

7 Use the Prefix field to specify a default prefix for the created files. This default prefix can 
be changed by every analyst in the Instrument context for each chip run.

Serial Number Inserts the serial number of the Agilent 2100 bioanalyzer 
instrument used for the chip run.

Date Inserts the date of the chip run.

Time/Counter Inserts the time of the chip run/inserts an auto-incremented 
3-digit number.

Option Meaning
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How to Set Run and Result Options

You can select several options such as to pause the analysis on setpoint changes, the 
maximum log file size, or the graph colors.

To set the Run and Result options:

1 Switch to the System context and select the System Wide Settings tab.

2 Select Run and Result in the tree navigation.

The Run and Result screen becomes visible:

3 In the Advanced section, you can 

– select Limit the storage of system log if you want to limit the disk space for the 
system log file “SystemLogBook.log” (located in the “..\log” subdirectory), and enter 
an upper limit in MB. 
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If the limit is exceeded, a message appears that prompts you to delete or move the 
log file to get free disk space.

– select Auto Run to activate the automatic start of a chip run once the lid of the 
Agilent 2100 bioanalyzer is closed and a chip suiting the selected assay is detected.

– select Auto Print to enable the automatic report printing function.

You can now click Settings to display the Autoprint dialog box, where you set the 
options for automatic printing after a chip run is complete.

NOTE
The Auto Print settings are independent from those made via the Print command of 
the File menu.

4 In the Analysis section, you can activate the Pause Analysis on Setpoint Change 
function.

If this function is not active, the measurement results are recalculated every time after 
you change a setpoint. If you need to change several setpoints at once, activating this 
function saves you time, because the results are only recalculated when leaving the 
setpoint explorer or when starting the analysis manually with the start button.

5 In the Graph Signal Color section, click the colored rectangles to the right of the signals. 

You can now choose a new color for the selected signal in the Color dialog box.
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How to Set Auto Export Options

To define auto export options:

1 Switch to the System context and select the System Wide Settings tab.

2 Select Auto Export in the tree navigation.

The Auto Export screen becomes visible:

3 Activate the Auto Export check box, if you want a data file to be exported automatically 
after every chip run.
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4 In the Electrophoresis Export section, specify which elements are to be included in the 
exported file for electrophoresis measurements.

5 In the Flow Cytometry Export section, specify which elements are to be included in the 
exported file for flow cytometry measurements.

6 Select Default Export Directories in the tree navigation and define the default 
directories for the various file types. Optionally, you can activate the Create daily 
subdirectories check box to automatically export the files of each day to separate 
directories.

How to Activate Software Licenses

By installing the 2100 expert software you have also installed a license administration 
tool. This tool is used to activate the different software modules. The following licenses 
can be ordered separately:

• 2100 electrophoresis license

• 2100 flow cytometry license

• 2100 security pack license

• 2100 instrument control license
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To activate an additional software license:

1 Select Registration from the Help menu to open the License Administration Tool 
window.

2 Switch to the Add License tab.

3 In the Select Product field, the Agilent 2100 Bioanalyzer must be selected.
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4 In the Select Module field, select the license for the software module that you want to 
activate.

5 Enter the correct License Key and click the Add button.

A message box informs you whether the license key was added successfully.

6 If you want to add more licenses, repeat the previous two steps for every license key.

7 Click the Exit button to close the License Administration Tool window.

The licensed software modules are now activated and can be used.

NOTE
If you added the license key to activate the security pack, the 2100 expert software 
closes and the secured file area will be set up. Follow the instructions displayed in the 
different pages of the setup wizard.
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NOTE
Store your license keys in a secure place and make sure you do not lose them.
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Using Log Books

2100 expert provides several log books to document all relevant actions and changes. 
Due to requirements of data integrity and data security, none of the log books can be 
cleared.

Run Logs

The run log books can be found in the following contexts as sub-tabs of the Log Book tab:

• Data context 

• Verification context

• Comparison context

• Assay context

They contain events such as the start and end time of a chip run, and any errors or 
problems that occurred during the run. 

All run logs are saved in the data files within the respective context. 
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System Log

The system log book can be found in the System context as a sub-tab of the Log Book 
tab.

It includes start-up and shut-down events of the 2100 expert software, and, for example, 
errors or problems with the connected bioanalyzers. 
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The system log book is saved in config/SystemFile.xml. The log book entries can be 
exported from this file.

How to Change the Display of the Log Books

To sort a log book table:

1 Click the column header you want to sort the table by.

The log book table is sorted by the entries in the selected column in ascending order.

2 Click the column header again to reverse the order.

To filter a log book table:

1 In the Log Book toolbar, click Filter .

The Filter dialog box appears.

2 To define a filter for events from a specified period of time, specify a Start Time and an 
End Time.

3 To define a filter for events with certain entries in a column, specify the column name 
and the value to search for.

4 Use the Filter Action radio buttons to define whether only events that match the filter 
criteria are displayed (FilterActionHide) or whether those events are highlighted while 
the others are still listed (FilterActionHide).

5 Click OK to apply the filter to the log book table.

The filter definition in the following example excludes all events from the Run Log in the 
Data context with an Event Type other than Critical.
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o

To remove the filter from a log book table:

In the Log Book toolbar, click Reset .

T IP
You can hide/show any of the log table columns, and re-sort the columns by 
right-clicking the table and selecting Columns from the context menu.
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How to Search the Log Book

You can search the various log books for any string. 

To search the Log Book:

1 In the Log Book toolbar, click Find .

The Find dialog box appears.

2 Enter a search string in the Find What field.

3 Use the Column selection list to specify whether you want to search all columns or a 
particular column only.

4 Select the search Direction.
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5 Click Find Next.

If the search string was found in an event, the event row gets highlighted in yellow.

NOTE
The search is case-sensitive!

6 To continue the search, click Find Next.
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Running Instrument Diagnostics

2100 expert provides several tests to check proper functioning of the bioanalyzer 
hardware. You should perform the tests on a regular basis, or if incorrect measurements 
occur.

You can test the following:

• Generic bioanalyzer tests, which can be run with both types of cartridges (electrode or 
pressure cartridge)

• Bioanalyzer in combination with electrode cartridge (electrophoresis setup)

• Bioanalyzer in combination with pressure cartridge (flow cytometry setup)
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Generic Bioanalyzer Tests

Diagnostics Test Purpose

Electronics Test Verifies proper functioning of all electronic boards in the 
bioanalyzer.

Fan Test Checks if the fan is running at the appropriate speed.

Lid Sensor Test Verifies proper operation of the lid sensor, ensuring that the 
laser and LED are off when the lid is open.

Stepper Motor Test Checks for proper movement of the stepper motor.

Temperature Test Checks if the temperature ramp-up speed of the heater plate is 
within specifications.
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Electrode Cartridge Tests

Diagnostics Test Purpose

HV Stability and 
Accuracy Test

Tests high voltage accuracy and stability of all 16 high voltage 
power supplies and the high voltage controller. Unused chip 
(DNA, RNA, or protein) required.

HV Accuracy Test 
(On-Load)

Check of channel-reference diode in transmission direction.

Short Circuit Test Checks for instrument leak currents using an empty chip. 

Note: the limits of this test specify an ambient temperature of 
25 °C and relative humidity less than or equal to 60 %. Higher 
temperatures or relative humidity could result in a leak current.

Electrode/Diode Test Checks the photo diode and current-versus-voltage 
performance of the bioanalyzer. Electrode/diode test chip 
required.

Optics Test Checks for proper alignment of internal optics and proper 
function of the laser and LED.

Electrophoresis 
Autofocus Test

Checks the focusing capability of the optical system. 
Autofocus test chip required.

Laser Stability Test Measurement of stability of red laser signal.
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Pressure Cartridge Tests

NOTE
With bioanalyzer model G2938A only diagnostic tests in combination with the 
electrode cartridge can be performed.

Diagnostics Test Purpose

Pressure Offset Test The vacuum system of the pressure cartridge consists of a 
pump and the corresponding tubes. This test calibrates the 
pressure sensors to zero.

Pressure Control Test Checks if the bioanalyzer is able to hold the working pressure 
of -140 mbar. During the test pumps stay on, while the system 
tries to regulate pressure to be kept at -140 mbar. Cell 
Autofocus test chip required.

System Leak Test Checks if the bioanalyzer is able to maintain a vacuum. 
Produces a test pressure of -100 mbar and monitors for 
changes. Cell Autofocus test chip required.

Flow Cytometry 
Autofocus Test

Checks that the optical system of the bioanalyzer is correctly 
calibrated. Cell Autofocus test chip required.
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Test Chips

Depending on your bioanalyzer setup (electrophoresis or flow cytometry), different test 
chips are required to run some of the diagnostics tests. Test chip kits are part of the 
bioanalyzer electrophoresis set (G2947CA) and flow cytometry set (G2948CA):

Test Chip Kit for Electrophoresis Assays (reorder no. G2938-68100)

Test Chip Kit for Flow Cytometry Assays (reorder no. G2938-68200)

Test Chip Comment Quantity

Autofocus Test Chip Values for fluorescence and offset are printed on 
the chip. Can be used multiple times.

1

Electrode/Diode Test Chip Can be used multiple times. 1

Test Chip Comment Quantity

Cell Autofocus Test Chip Required for Pressure Control Test, System 
Leakage Test, and Optical Drive Test. Can be 
used multiple times.

1
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How to Run Instrument Diagnostics Tests

NOTE
Diagnostics tests cannot be run while the 2100 expert software is performing a chip 
run.

To run diagnostics tests:

1 Switch to the Instrument context.

2 In the Tree View Panel, select the bioanalyzer on which you want to run the tests.

3 Switch to the Diagnostics tab.

All available tests are displayed in the Available Tests list. The tests that can be 
executed depend on the type of cartridge that is installed in the bioanalyzer.

The 2100 expert software will generate an error message if a wrong cartridge type is 
detected for the selected assay. To run the selected test please insert the requested 
cartridge type (see “Loading the Electrophoresis Chip into the Bioanalyzer” on page 59 
or “Loading the Cell Chip into the Bioanalyzer” on page 194, respectively).
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4 Select the tests you want to run:

– Select the Apply check boxes to select single tests.

– Click Select All to select all available tests.

– Click Unselect All to deselect all tests.

5 Click Start.
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6 Follow the instructions given by the 2100 expert software. For example, exchange the 
cartridge, or put a test chip in the receptacle of the bioanalyzer when requested by the 
software.

All selected tests are performed. 
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The Status column indicates the status of each test:

– Executing

– Execution pending

– Executed, passed

– Executed, failed

7 If any test failed, redo the test.

8 If failures still persist, contact Agilent service.

The results of diagnostics tests are stored in .xdy files in the 2100 expert installation 
folder under “..\diagnosis”. If tests fail, send the .xdy files to the Agilent service.
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Performing Verifications

To ensure a validated Agilent 2100 bioanalyzer system, verification steps have to be 
performed at installation and operation level.

2100 expert allows for detailed installation verification and system verification on both 
the bioanalyzer hardware and software. Each verification comprises a series of tests and 
measurements that you can run and document in the Verification context of the 
2100 expert software. 

Installation Verification

Installation verification includes tests to verify that the bioanalyzer software and 
hardware are installed properly and that all electrical and pressure connections are 
correct.

Installation verification must be performed once after installation.
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System Verification

System verification proves that the bioanalyzer system is suitable for its intended use, 
that is, that it will function according to its operational specifications in the selected 
environment.

System verification should be performed:

• at first use of the instrument,

• after relocating the instrument,

• after changing essential parts of the system, for example software updates or exchange 
of cartridges,

• after instrument repair,

• on regular time intervals.

Verification Procedure

To perform verification tests:

1 Switch to the Verification context.

2 From the File menu select New.

3 A New Verification item appears in the Tree View Panel.

4 Under Cartridge Details, click Select and specify details on the cartridge that is currently 
installed in the bioanalyzer.
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5 Under Configure 2100 Bioanalyzer HW Test Chips, enter the test chips you will use for 
this verification:
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6 In the Tree View Panel, navigate to the test category you want to execute. Select the 
category via Installation/System Verification – Software/Hardware – PC 
name/Bioanalyzer name – Test Category.

NOTE
To execute hardware tests (HW branch) the bioanalyzer must be properly connected 
and switched on.

The Configuration tab now lets you select verification tests to be executed in the 
verification run:

To select tests, check the Apply check box next to the test(s).
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7 To start the selected tests, click Start button in the toolbar.

The Save As dialog box appears.

8 Specify a name and location for the verification results file (.xvd) and click Save.

The selected tests are executed. 
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9 If a test fails, you can Repeat test execution, Abort the verification run, or skip the 
current test and Continue with the next test:

10After all tests have been executed the following message appears:

11Click OK.
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12The Status column shows which of the tests have been run successfully, which have 
failed, and which have mixed results with multiple executions. 
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13To view details on test execution, select the Results tab.

14You can now navigate to other test categories and execute additional verification tests.
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15When you close the verification result file (File > Close), try to switch to another 
context, or exit 2100 expert, the following message appears:

If you select No, you return to the Verification context and can run further verification 
tests.

If you select Yes, the verification result file (.xvd) is closed and becomes read-only. 

NOTE
You can re-open verification result files only for viewing and printing.

T IP
Select File > Print to generate a printed report of the verification run.
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Products, Spare Parts, and Accessories

To buy the following products, spare parts and accessories for the Agilent 2100 
bioanalyzer, please refer to the Agilent Online Store:

http://www.agilent.com/home/buyonline.html

Bundles

• G2940CA – Agilent 2100 bioanalyzer desktop system

Includes Agilent 2100 bioanalyzer, HP Compaq desktop PC, color printer, system 
software, vortexer, and accessories. Cartridge and license must be purchased 
separately.

• G2943CA – Agilent 2100 bioanalyzer laptop system

Includes Agilent 2100 bioanalyzer, HP Compaq laptop PC, color printer, system 
software, vortexer, and accessories. Cartridge and license must be purchased 
separately.

http://www.agilent.com/home/buyonline.html
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Hardware

• G2938C – Agilent 2100 bioanalyzer

Includes 1 chip priming station, 1 test chip kit, serial cable, Installation and Safety 
Manual. Cartridge and license must be purchased separately.

• G2947CA – Agilent 2100 bioanalyzer electrophoresis set

Includes test chip kit, electrode cartridge, license key for electrophoresis assays, and 
start-up service.

• G2948CA – Agilent 2100 bioanalyzer flow cytometry set

Includes checkout kit, test chip kit, pressure cartridge, license key for flow cytometry 
assays, and start-up service.

Software and Services

• G2946CA – Agilent 2100 expert software upgrade

Software package for upgrade to the latest 2100 bioanalyzer system software revision.

• G2949CA – Agilent 2100 expert security pack

Additional services for Installation Qualification (IQ) and Operation 
Qualification/Performance Verification (OQ/PV) as well as assay consulting are 
available and can be ordered separately.
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Spare Parts and Accessories

• 5065-4413 – Electrode cartridge

• 5065-4492 – Pressure cartridge

• 5065-4478 – Pressure Adapter Kit

Contains 5 plastic adapters and 1 mounting ring for use with the pressure cartridge

• G2938-68100 – Test Chip Kit for Electrophoretic Assays 

Comprises 1 Autofocus, 1 Electrode/Diode, and 5 Leak Current Clips

• G2938-68200 – Test Chip Kit for Flow Cytometric Assays

Comprises 1 Cell Autofocus Chip

• G2938-81605 – RS 232 cable

Communication cable PC – Agilent 2100 Bioanalyzer

• 2110-0007 – Fuse

• 5042-1398 – Adjustable Clip for use as spare part for the chip priming station

• 5065-4401 – Chip Priming Station including gasket kit and adjustable clip

• G2938-68716 – Gasket Kit

Includes spare parts for the chip priming station: 1 plastic adapter, 1 ring and 10 gaskets 

• 5065-4428 – IKA Vortexer (115V)

Must be ordered at IKA (http://www.ika.de)

• 5065-4429 – IKA Vortexer (230V)

Must be ordered at IKA (http://www.ika.de)

http://www.ika.de
http://www.ika.de


Contents ▲ 343 ▼ Index

• 5065-9966 – Vortex Mixer Adapter for IKA vortexer

• 5065-9951 – Electrode Cleaner Box

Contains 7 electrode cleaners

• G2946-60002 – Agilent 2100 bioanalyzer How to Use CD-ROM

Contains videos showing the chip preparation for all assays and the hardware 
maintenance
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Glossary

This glossary explains terms in context with flow cytometry, electrophoresis, and 
software or hardware of the Agilent 2100 bioanalyzer.

A

Area Threshold

The Area Threshold setpoint determines the minimum amount of peak area that must be 
detected before a peak is recognized.

Assay

An assay is a solution with defined chip, chemicals, instrument methods, data analysis, 
data output settings and data display settings. 

ASY file

In Bio Sizing electrophoretic assays were stored as .asy files. 2100 expert can import .asy 
files. See also XSY file.
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Audit Trail

Audit trails are available in the 2100 expert software only with the security pack installed. 
They are used to record the activities of the logged-in users and cannot be modified. The 
audit trails as well as log books are subject to data protection. Only authorized users are 
allowed to inspect them. They are saved with the data files or into an audit file repository, 
which is automatically archived. 

B

Baseline

A baseline is established just after the First Peak Time setpoint. After the overall baseline 
is established, a local baseline is calculated for each peak to compensate for baseline 
drift.

For isolated peaks, the local peak baseline is simply a straight line connecting the Start 
Point of the peak with the End Point. For peaks that are very close together, an average 
baseline is used when the value between the peaks does not drop to the actual baseline.
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The figure below shows baselines established for DNA assay peaks. Peaks for DNA and 
protein assays are determined on a peak-by-peak basis (the overall baseline is shown).
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The figure below shows baselines established for Total RNA assay fragments. Total RNA 
fragments are determined on a peak-by-peak basis and an overall baseline is shown from 
the start to end time. 
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The figure below shows baselines established for an mRNA assay. mRNA fragments are 
determined on a peak-by-peak basis and an overall baseline is shown from the start to 
end time.
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NOTE
With RNA assays, you can move the lines marking the start and end points for data 
analysis (shown by the long-dashed vertical green lines) which will adjust the entire 
baseline for calculation of the area of the total sample. 

Baseline Plateau

This setpoint (found in the setpoint explorer) rejects brief, low slope areas such as at 
peaks and between non-baseline-resolved peaks. The signal is recognized to be at 
baseline whenever the slope of the data is less than the Slope Threshold setpoint (either 
positive or negative) for longer than the time set for the Baseline Plateau.

BMP file

BMP is the standard Windows image format. The BMP format supports RGB, 
indexed-color, grayscale, and bitmap color modes.

Bubble

If the tip of a pipette is not positioned all the way to the bottom of a well, bubbles can 
result (and sometimes bubbles happen even when you are very careful). The vortexing 
step that occurs after samples are loaded into the chip is designed to rid the wells of 
bubbles and is usually very effective.

If a large bubble is seen at the bottom of a well, remove the sample from the well, pipette 
it back in, and continue with the loading procedure.
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C

CAD file

In Cell Fluorescence flow cytometric chip runs were stored as .cad files. 2100 expert can 
import .cad files. See also XAD file.

Center Point

After locating a start point, the peak find algorithm looks for the first negative slope value 
and saves the previous point as the center. If the value of the center point is less than the 
Minimum Peak Height, the algorithm starts looking for a new peak.

CLD file

In Bio Sizing electrophoretic chip runs were stored as .cld files. 2100 expert can import 
.cld files. See also XAD file.

COM Port

See Serial port.

CSV file

Comma-separated variable file. The simplest form of file for holding tabular data. Data is 
listed in columns in a text file, each value being separated by a comma. Each new line 
represents a new set of data. Import and export with Microsoft Excel is possible.

CSY file

In Cell Fluorescence flow cytometric assays were stored as .csy files. 2100 expert can 
import .csy files. See also XSY file.
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D

Data Filtering

The first step 2100 expert takes in analyzing raw data is to apply data filtering. Data 
filtering is done by means of a polynomial “filter” that is applied to the raw data. The 
setting for the Polynomial Order in the setpoint explorer determines the amount of data 
to be applied: the smaller the number, the more data that is applied and the more filtering 
that takes place. 

Data Points

Data points are 0.05 seconds apart.

Show Data Points is an option that enables the display of the data points used to 
generate the graph. 

E

Electrode Cleaner

An electrode cleaner should be used to clean the electrodes after each run is complete. 
The cleaning procedure is slightly different depending upon the type of assay that was 
just performed (DNA or RNA).

The electrode cleaner looks like a chip except that it is clear. With RNA assays you must 
use two different electrode cleaners: one for general cleaning using RNAse-free water 
and another for decontamination using RNAseZAP. It is recommended to use a 
permanent marker to label the electrode cleaners so as not to mix them up.
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Electrokinetic forces

Electrokinetic forces are used to move, switch and separate the samples. Active control 
over voltage gradients directs the movement of materials using the phenomenon of 
electrophoretic flow.

Electroosmotic Flow

A phenomenon that results from an electrical double layer formed by ions in the fluid and 
surface electrical charges immobilized on the capillary walls. When an electric field is 
applied, the bulk solution moves towards one of the electrodes. This phenomenon can be 
used to move fluids through microfabricated channels.

Electrophoresis

A standard technique of separating molecules on the basis of their mobility 
(charge-to-mass ratios). An electrical potential is applied across a capillary containing a 
sample in a fluid medium. Positive molecules migrate towards the cathode and negative 
molecules migrate towards the anode at different speeds, depending on their 
electrophoretic mobility.

Electrophoretic flow

A macroscopic phenomenon that results from an electrical double layer formed by ions in 
the fluid and surface electrical charges immobilized on the capillary walls. When an 
electric field is applied, the bulk solution moves towards one of the electrodes (cathode). 
Electrodes sit in the reservoirs that connect to the ends of the various channels. 
Electrode potentials are applied to the various reservoirs in a time-dependent fashion to 
move the fluid in the required direction. The gel-filled channels of the LabChip devices do 
not exhibit a measurable flow because of dynamic channel coating and viscosity of the 
polymer matrix.
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End Point

The peak find algorithm looks for a leveling off when the value of the slope is less than 
the value set for the slope threshold. This is considered to be the end point of the peak. 

With RNA assays, individual peak end times can be moved manually by dragging the 
diamond-shaped end points shown in the single-well display.

End Time

This setpoint determines the time after the start of a run before which the last peak or 
fragment will be located (any peaks appearing after this time are ignored). In RNA 
assays, the end time is shown on the single-well display as a long-dashed vertical green 
line.

With RNA assays, another End Time setpoint is available that controls the end time for 
an individual peak. Additionally, individual peak end times can be moved manually by 
dragging the diamond-shaped end points shown in the single view.

F

Filter Width

This setpoint determines the width of the polynomial (in seconds) to be applied to the 
data for filtering (noise reduction). The default depends on the assay selected. This 
setting should be less than twice the width of the peaks of interest or the peaks will be 
distorted. Peaks that are distorted by the filter have positive and negative peaks on both 
sides. To see an example of such distortion, increase the filter width to 5.
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Firmware

The firmware is a program to control the hardware of the Agilent 2100 bioanalyzer. It is 
downloaded from your computer to the Agilent 2100 bioanalyzer and controls, among 
others, data transfer or the measurement procedures.

Flow Cytometry

A method to detect cells with certain properties. In a continuous stream, stained cells 
pass through a light beam. The emitted fluorescence is used for counting and 
differentiation.

Flow Cytometry Standard—FCS

The FCS file format is the standard format used in flow cytometry to exchange data 
between several applications.

G

GIF file

Graphics Interchange Format, GIF is a graphics file format that uses a compression 
scheme originally developed by CompuServe. Because GIF files are compressed, the file 
can be quickly and easily transmitted over a network. This is why it is the most commonly 
used graphics format on the World Wide Web.

H

Height Threshold

The Height Threshold setpoint determines whether a peak is kept. It represents the 
minimal peak height. For each peak, the difference between the start point value and the 
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center point value (local baseline) must be greater than the Height Threshold value.

This setting is chosen in the setpoint explorer.

Histogram

Histograms are bar charts to display, for example, a frequency distribution.

HTML file

HTML (Hyper Text Markup Language) is the authoring language used to create 
documents on the World Wide Web. HTML defines the page structure, fonts, graphic 
elements and hypertext links to other documents on the Web.

J

JPG file

Joint Photographic Experts Group Image File. A JPEG file is a compressed raster or 
bitmapped graphic image. When a JPEG is created, a range of compression qualities may 
be considered. JPEG compression is a lossy process, which means that you sacrifice 
quality for file size the more you compress the image (the highest quality images results 
in the largest file size). Whereas GIF images are limited to 256 colors (8-bit), JPEG images 
may contain millions of colors (24-bit) as well as additional information including 
PostScript clipping paths.



Contents ▲ 356 ▼ Index

L

Lab-on-a-chip

The generic term for a microfluidic product, signifying a chemical process or material 
movement taking place on a microchip. In contrast to analysis in a standard laboratory 
that relies on human intervention at several stages to manipulate or observe samples 
and record results, the self-contained lab-on-a-chip represents an almost hands-free 
technology.

Lab-on-a-chip technology means downsizing of analytical techniques from lab-scale to 
chip-scale:

• using techniques like electrophoresis, chromatography, and sieving.

• with fluorescence, absorbance, and MS detection.

• with a higher degree of automation, integrating multiple steps of a complex protocol 
into a miniaturized system.

Virtually any biochemical testing that can be done in a laboratory can theoretically be 
done on a chip.

Ladder

Each electrophoretic LabChip Reagent kit contains a ladder. A ladder contains DNA, RNA 
fragments or proteins of known sizes and concentrations. 

A ladder well is located at the bottom right of the chip. The ladder is analyzed first before 
sample analysis takes place.
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The peak sizes and markers defined for the ladder are assigned consecutively, starting 
with the first peak detected in the ladder. Peaks appearing above the upper marker do not 
have to be detected. The peak table for the ladder well shows the peak size and 
concentration.

Lower Marker

An internal standard that is added to a sample in a well to assist in determining size of 
the sample. The lower marker is the same as the first peak found in the DNA ladder.

M

Method

Methods are available in the 2100 expert software only with the security pack installed. A 
method is referred to as an electrophoretic or flow cytometric assay with additional 
information stored to it. This additional information includes instrument information, 
study information, report settings, and workflow definitions.

Microfluidics

The movement of liquids through micro-fabricated structures by means of electrical 
fields or pressure/vacuum, holding the promise of greater functionality with significantly 
improved reliability:

• small glass or plastic devices with micro-channels as experimental platform

• active control of fluids without moving parts on-chip through miniature electrodes or 
pumps controlled by software scripts

• emulation of conventional liquid pumps, valves, dispensers, reactors, separation 
systems, etc.



Contents ▲ 358 ▼ Index

• capability of liquid transfer, separation, dilution, reactions and more

Molarity

 

where:

Molarity is measured in nanomoles per liter (nmol/l)

Concentration is measured in nanograms per microliter (ng/µL)

Size is measured in base pairs (bp)

 is the molecular weight of a single base pair

Miniaturized laboratories on a microchip

Expression used to describe lab-on-a-chip technology.

Molecular separation techniques

Processes such as gel electrophoresis, liquid chromatography and capillary 
electrophoresis that can separate bimolecular organic substances from other 
compounds.
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P

PDF file

PDF (Portable Document Format) is a file format created by Adobe Systems Incorporated 
that preserves all of the fonts, formatting, colors, and graphics of any source document, 
regardless of the software and computer platform used to create it.

Peak Baseline

A local peak baseline is calculated for each peak. For isolated peaks, the local peak 
baseline is simply a straight line connecting the start point with the end point. For peaks 
that are very close together, an average baseline is used when the value between the 
peaks does not drop to the actual baseline.
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Peak Filter Width

The Peak Filter Width setpoint determines the minimum amount of time that must elapse 
before a peak is recognized.

Peak Height

The value at the center point of the peak minus the local baseline start value.

Point-to-Point Fit

This curve fit is composed of line segments between each pair of data points that are 
used to interpolate data between those points.
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Polynomial Filter

The first step 2100 expert takes in analyzing the raw data is to apply data filtering. Data 
filtering is done by means of a polynomial “filter” that is applied to the raw data.

Priming Station

Consists of a chip holder that has a syringe mounted on the lid that seals over the chip. 
The syringe is used to force the buffer solution loaded into the well marked “G” with a 
circle around it into all the passageways inside the chip prior to running it in the 
bioanalyzer.
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S

Serial port

The serial ports (COM ports) are used to connect your computer with the Agilent 2100 
bioanalyzer. The number of available ports depends on the computer you use.

Signature

Signatures are available in the 2100 expert software only with the security pack installed. 
All activities on data such as creating, modifying, and deleting data must be confirmed by 
the user with an electronic signature (user name and password). By requesting this 
signature it is ensured that only authorized users can create, modify, and delete data.

Slope Threshold

The Slope Threshold setpoint determines the difference in the slope that must occur in 
order for a peak to begin. The inverse of this value is used to determine the peak end.

Standard Curve

The standard curve is obtained by plotting the size of the ladder peaks vs. time using a 
point-to-point fit. For each sample peak, the center time is interpolated from the Standard 
Curve to determine the peak size in base pairs.

Start Point

The peak find algorithm walks the data from time zero looking for a slope greater than the 
Slope Threshold. This is considered to be the start point of a peak.

With RNA assays, individual peak start times can be moved manually by dragging the 
diamond-shaped start points shown in the single view.
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Start Time

This setting determines the time after which the first peak or fragment will be located 
(any peaks appearing before this time are ignored). In RNA and Protein assays, the start 
time is shown on the single view display as a long-dashed vertical green line (note that 
this is true for protein assays when analysis is on; the start time is shown as a solid 
green line when analysis is off for protein assays).

With RNA assays, another start time setting is available that determines the start time 
for an individual peak. With RNA assays, individual peak start times can be moved 
manually by dragging the diamond-shaped start points shown in the single view.

T

Tool Tip

A small box containing text that describes the item indicated by the mouse pointer. To 
view a Tool Tip, position the mouse pointer over an object on the screen. Leave the 
mouse stationary for a moment and a Tool Tip (if one exists for that item) will appear.

TIF file

A file extension indicating one of a set of popular bitmap graphics formats. Tiffs are 
commonly used in DTP work because of their support for color specification. 
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U

Upper Marker

An internal standard that is added to a DNA or Protein sample in a well to assist in 
determining size and concentration of the sample. The upper marker is the same as the 
last peak found in the sizing ladder.

W

WAV file

A type of computer file used to store a sound digitally.

Workflow

The workflow defines the order of steps that need to be taken for a measurement to 
ensure data validity and data reliability. This includes steps such as the execution of 
methods, result reviews, and the final approval.

The workflow definition is part of the methods and is available in the 2100 expert 
software only with the security pack installed. 

WMF file

Windows Metafile. Windows metafile documents can contain any mix of vector and 
raster (or bitmapped) information to describe the contents of an image. WMF graphics 
are generally used on the Windows platform as a standard format for clip art and other 
graphically rich information such as charts.
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X

XAD file

2100 expert chip data file. The files contain raw data, assay information, data analysis 
setpoints, information on chip, samples and study, and the run log information.

XAC file

2100 expert comparison file. 

XLS file

Microsoft Excel spreadsheet file.

XML file

Extensible Markup Language files. XML is the Extensible Markup Language, a system for 
defining specialized markup languages that are used to transmit formatted data. XML is 
conceptually related to HTML, but XML is not itself a markup language. Rather it is a 
metalanguage, a language used to create other specialized languages. 

2100 expert uses the XML format to:

• export chip data

• save and load result flagging rules.

XSY file

2100 expert assay file. The files contain the assay properties, data acquisition settings, 
and information on chip, samples, and study.
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XVD file

2100 expert verification result file. The files contain results of verification tests regarding 
the bioanalyzer hardware and software. xvd. files are stored in the “..\validation” 
subfolder of the 2100 expert installation directory. For each verification run, an .xvd file is 
generated. 

Date and time of the verification run are included in the file name. Example: 
“Verification_23-05-2005_10-28-40”.
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Z

Zero Baseline

All electropherograms produced with the bioanalyzer show some amount of background 
fluorescence. By default, the 2100 expert software enables the zero baseline function. 
Enabling this setting offsets the graphs shown for the individual wells but does not affect 
analysis. The mean of 100 points before the baseline time (derived when calculating well 
noise) is used as the zero baseline value.

Zero Baseline



Contents ▲ 368 ▼ Index

To remove the zeroing, disable the Zero Baseline box in the setpoint explorer (baseline 
calculation under Global and Advanced setting).

None-Zero Baseline
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A
Accessories, 340
Adding regions, 240
Agilent Online Store, 340
Alignment, 133
Antibody staining, 249
APC, 174
Apoptosis assays, 253
Assay setpoints, 268
Assays

Creating new, 270
Generic, 183
Opening, 271
Predefined, 181
Stopping, 68, 205

Auto Print, 310
Auto Run, 310

B
Base pair, 358
Baseline, 129
Bioanalyzer manuals, 8
Bioanalyzer tests, 323
Bubbles, how to avoid, 192

C
Calcein, 173
Capillary electrophoresis, 358
Cartridges, 59, 194
CBNF, 174
Cell detection, 175
Chip reagents, 191
Color

overlaid histograms, 235
Color indicators on setpoints, 122
Comparing samples, 148
Comparison context, 148
Configuring markers, 228
Context

definition, 34
Copy

Markers, 231
Regions, 245

Creating new assays, 270
Cy5, 174
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D
Data

specify file names and directories, 306
Data analysis setpoints, 117
data analysis setpoints, 268
Data files, 266
Data points, 77, 214
Documentation, related, 8
Dot Plot

generating, 179
Dyes, 173

E
Electrode cartridge, 59
Electrodes, 61, 195
Electrokinetic forces, 352
Electroosmotic Flow, 352
Electrophoresis, 352
Electrophoretic flow, 352
Event, 176

F
Fluorescence dye, 47

G
Gates

working with, 246
Gating, 220

direction, 231
Gel electrophoresis, 358
GFP, 173
GFP assays, 259
Green fluorescent protein, 173, 259

H
Histogram

generating, 177
overlaying, 233

I
Inserting marker, 226
Inserting peaks, 141
Installation verification, 331
Inverse pipetting, 192

L
Lab-on-a-Chip, 356
Laboratories on a microchip, 358
Liquid chromatography, 358
Log

Run log, 316
System Log, 317
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M
Manual integration, 136
Marker, 219

configuring, 228
copying, 231
inserting, 226
limits, 230
removing, 227

Micro-channels, 47
Microfluidics, 357
Molecular separation techniques, 358
Molecular weight, 358
Multi channel mode, 74, 211

N
Navigation, 75, 212

O
Opening assays, 271
Overlay histograms, 233

color and scale, 235

P
Pressure cartridge, 194
Products, 340

Q
Quick Guides, 9

R
Raw data, 266
Reagent Kit Guides, 8
Reagents, 191
Region table, 115
Regions, 180

adding, 240
configuring, 242
copying, 245
size and position, 244

Related documentation, 8
Removing peaks, 139
Result flagging, 157

defining rules, 164, 166
exporting rules, 291
importing rules, 282

Result table
histogram values, 236
regions, 247

RIN, 91
RNA integrity number, 91
Run log, 316
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S
Scale

overlaid histograms, 235
Setpoint Explorer, 118
Setpoints, 268
Show data points, 79, 216
Sieving polymer, 47
Single channel mode, 74, 211
siRNA Transfection Viability, 182
Smear analysis, 113
Spare parts, 340
Staining cells, 173
Starting an assay, 65, 201
Stop assay, 68, 205
System Log, 317
System verification, 331
SYTO16, 173

U
Undo zoom, 78, 215

Z
Zoom

Dot Plot, 77, 214
Histogram, 77, 214
Undo, 78, 215
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